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Preface
This preface introduces you to the Oracle Maintenance, Repair and Overhaul Master
Configuration WorkBench User’s Guide.
This preface provides information on the following topics:
■

Audience

■

How this User’s Guide Is Organized

■

Document Conventions

■

Typographical Conventions

■

Other Sources of Information

xiii

Audience
This guide is an important source of information about the Master Configuration
WorkBench. It provides useful information to:
■

Engineering staff

How this User’s Guide Is Organized
Chapter 1: Overview
This chapter provides an overview of Oracle MRO and the Master Configuration
WorkBench.

Chapter 2: Getting Started
This chapter explains how to log on to the Master Configuration WorkBench.

Chapter 3: Preparing the Data
This chapter explains how to create the files needed to build a master configuration.

Chapter 4: Parsing, Database Building, and Figure Mapping
This chapter describes the process of parsing the configuration files, building the
master configuration database, mapping figures, and creating hotspots.

Chapter 5: Verifying the Database
This chapter describes the process of visually verifying the database and comparing
the master configuration database with the item master database.

Chapter 6: Linking Routes
This chapter describes how to link routes with index numbers on images.

Chapter 7: Creating a New Master Configuration
This chapter describes how to create versions of a master configuration based on the
same IPC.

xiv

Document Conventions
The following document conventions are used in this user’s guide.

Notes
Notes provide extra information about a procedure that needs to be highlighted or
would break up the procedural flow if included within the steps. Such information
might include hints or advice, the system response to the previous step, or the
reasoning behind an action.
Note: This is a note used to call attention to some feature or fact
related to the previous paragraph.

Caution
Cautions are used to highlight information that you need to know to prevent an
Oracle MRO application from losing data or processing incorrectly. A Caution
precedes the step to which it applies.
Caution: This is a caution to call attention to information that you
need to know to prevent an Oracle MRO application from losing
data or processing incorrectly.

Warning
A warning draws attention to a situation that could result in personal injury or
equipment damage.
WARNING: This is a warning to call attention to some feature or
fact that could result in possible personal injury or equipment
damage.

Additional Information
The Oracle MRO documentation alerts you to additional or related information that
you may want to review. This information may be in a form description, report,
topical essay, appendix, or other Oracle or partner manuals.
Additional Information: This is to call attention to additional or related
information that you may want to review.

xv

Typographical Conventions
The following typographical conventions are used in this user guide:

Menus
Menus and menu commands appear in boldface type. Menu actions are described
in the following style:
Choose File->Quit means choose the Quit command from the File menu.

Windows
Within some windows are areas labeled to describe the type of information
contained in the area. These areas are defined by graphic lines and are referred to as
regions in procedures and in the tables that describe a window.
Window Regions

Window Buttons
Buttons that appear in windows are referred to by name in boldface type in the
following styles, depending if the button is labeled with a name, as shown in the
figure above, or a picture, as shown below.
Click Hold to put the job on hold.
Click the Map button on the toolbar. The Figure Mapper appears.

xvi

Other Sources of Information
Oracle Financials Manuals
You can choose from many sources of information, including documentation,
training, and support services, to increase your knowledge and understanding of
Oracle MRO.
These Oracle Applications manuals provide information about a number of topics
related to Oracle MRO.
General Ledger:
Oracle General Ledger Reference Manual
Oracle General Ledger User’s Guide
Oracle General Ledger Technical Reference Manual
Oracle General Ledger Applications Technical Reference Manual Update
Overview of Average Balance Processing in Oracle General Ledger
Accounts Payable
Oracle Payables Reference Manual
Oracle Payables Applications Technical Reference Manual
Oracle Payables Applications Technical Reference Manual Update
Oracle Payables User’s Guide
Oracle Cash Management Technical Reference Manual Update
Oracle Cash Management User’s Guide
Oracle Cost Management User’s Guide
Accounts Receivable
Oracle Receivables Tax Manual
Oracle Receivables Applications Technical Reference Manual
Oracle Receivables Applications Technical Reference Manual Update
Oracle Receivables User’s Guide
Oracle Receivables Reference Manual

xvii

Purchasing
Oracle Purchasing Reference Manual
Oracle Purchasing Technical Reference Manual
Oracle Purchasing Technical Reference Manual Update
Additional Financial Manuals
Oracle Training Administration User’s Guide
Oracle Applications User Interface Standards
Oracle Applications System Administration Guide
Oracle Maintenance, Repair and Overhaul User’s Guides
The following user’s guides provide information about Oracle MRO.
Oracle MRO Access Control WorkBench User’s Guide
Oracle MRO Applications Extensions User’s Guide
Oracle MRO Implementation Guide
Oracle MRO Inspection/Assembly WorkBenches User’s Guide
Oracle MRO Installation Guide
Oracle MRO Master Configuration WorkBench User’s Guide
Oracle MRO Route Management WorkBench User’s Guide
Oracle MRO Unit Configuration WorkBench User’s Guide

xviii

1
Overview
This chapter provides information about the following topics:
■

Oracle MRO Overview

■

Master Configuration WorkBench Overview
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Oracle MRO Overview
Oracle MRO is an integrated suite of enterprise applications specifically designed to
meet the needs of servicing complex equipment such as jet engines, airframes,
locomotives, and semiconductor manufacturing equipment. Oracle MRO is the
Oracle solution for providers of maintenance, repair, and overhaul services. Oracle
MRO addresses the processes that are unique to the aftermarket service industry
and the challenges inherent in maintaining complex equipment.
The maintenance, repair, and overhaul industry is fundamentally different from
manufacturing. In the manufacturing environment, the product is owned by the
manufacturer, and a purchase agreements relates to the physical item. In a service
environment, that physical item belongs to the customer, and the purchase
agreement relates to services to be performed on the item.
The service environment requires more inventory management. When a part is
replaced, for example, the replacement part may come from the inventory of the
service provider, a third party, or the customer; or the replacement part may be
obtained by redirecting a part being repaired for another job. In addition,
replacement parts must be verified against the part requirements specified in the
Illustrated Parts Catalog (IPC) sales order, scope of work, and industry regulations.
MRO shop floor procedures are more complex and dynamic than manufacturing
procedures. The scope of work is often unknown until disassembly is under way,
and floating shop floor bottlenecks can further complicate procedures. Oracle MRO
manages such key MRO processes as receiving a unit for service; disassembling,
cleaning, and inspecting it; and dispositioning the parts. The system automates such
tasks as creating and modifying repair routes and scheduling repair procedures. All
costs associated with jobs are collected throughout the repair cycle and are
automatically sent to the integrated Oracle financial applications.
Typically, in the Oracle MRO environment, the following processes occur:

5.

A contract or sales agreement is negotiated for services to a customer’s product.
The customer ships the item.
The item is received. It may then be attached to a job, if a job exists, or assigned
to an inventory until a job is created.
The item is disassembled for service. The parts are dispositioned and reused,
repaired, and/or replaced. Parts to be serviced by an outside vendor are
shipped to the vendor, serviced, and received back.
All the parts destined for reassembly are accumulated at assembly locations.

6.

The product is assembled and tested and shipped back to the customer.

1.
2.
3.
4.
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IPC-Based Configuration Management
One of the key requirements of the MRO industry is configuration management.
Oracle MRO provides automated configuration management. This reduces
turnaround time and increases capacity by providing faster access to key
information and by providing decision-making support.
A service business needs to have parts available not only for all models currently in
production but also for models in service but no longer in production. Such models
have usually been modified and upgraded many times.
Oracle MRO configuration management is based on a product’s IPC. Oracle MRO
uses a decision graph to model product configurations. Using a decision graph
allows the representation of all possible Bills of Material (BOM). Each unit has an
as-maintained configuration that is updated to account for both depot and field
service. Part dependencies, part alternates, and part effectivity can be tracked as
well as part history (times and cycles). Manufacturer’s service bulletins can be
integrated into the configuration.
The ability to create and manage the as-maintained BOM for individual units leads
to efficient parts logistics and resource use, and to automatic and verifiable
compliance with customer and regulatory requirements.
Another aspect of configuration management is inventory management. Oracle
MRO provides complete visibility into inventory, allowing the consideration of all
alternate parts for each produced configuration.

The Oracle MRO Solution
The primary process in MRO is job execution, and the shop floor is the center of this
activity. The activities of the shop floor are reflected in inventory, labor, and cost
transactions. Shop floor decision making, such as selecting replacement parts, is
guided by such things as the as-maintained BOM, the contract, inventory, costing,
and scheduling. The Oracle MRO solution consists of Oracle Applications with
extended MRO functionality and new application called workbenches specifically
designed for the MRO environment. Figure 1–1 shows the Oracle MRO solution
footprint.

Oracle MRO WorkBenches
Oracle MRO contains these workbenches to support core MRO processes:
■

Master and Unit Configuration WorkBenches

■

Route Management WorkBench

■

Inspection WorkBench
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■

Assembly WorkBench

■

Access Control WorkBench

Figure 1–1 Oracle MRO Solution Footprint
New Applications
Engineering

System Administration

Access Control
WorkBench

Master Configuration
WorkBench

Shop Floor

WIP

Inspection
WorkBench

Unit Configuration
WorkBench

Assembly
WorkBench

Route Management
WorkBench

Costing

Inventory

Purchasing

Shipping &
Receiving

Extensions to Oracle Applications
Financials

Master and Unit Configuration WorkBenches Configuration management is handled
with two workbenches: the Master Configuration WorkBench and the Unit
Configuration WorkBench.
The Master Configuration WorkBench is used to create a master configuration,
IPC-based database representation of an item’s assembly model. This assembly
model defines the part, alternate part, reference information, and figures for each al
possible configurations. Assemblies, subassemblies, and parts shown in online
figures are electronically linked to the relevant information in the database and also
to the proper service procedures. From this database, information can be quickly
extracted to precisely define the configuration of any individual unit received for
service. This level of configuration is called a unit configuration and is created from
the master configuration with the Unit Configuration Workbench.
The unit configuration provides the structure that guides the inspection and
disposition process, including looking up parts and parts ordering. During the
inspection and disposition process, the IPC information in the unit configuration is
augmented to include such information as the disposition, times and cycles,
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individual part serial numbers, and service bulletins applied. The unit configuration
also stores the unit’s disassembly and reassembly configurations.
Route Management WorkBench The Route Management WorkBench is used to manage
shop floor procedures. It provides tools for developing and maintaining validated
service procedures. Route management functionality allows for versions, updates,
and effectivity. Routes can be classified in different ways. For example, routes can be
grouped by level of service, such as major and minor overhaul, or by type, such as
disassembly, cleaning, inspection, repair, assembly, and testing.
Inspection WorkBench The Inspection WorkBench is used on the shop floor to inspect
and disposition parts. This workbench is used to record findings and part
conditions and also to initiate job creation. The Inspection WorkBench allows
inventory look-up and parts ordering. Repair routes can be selected and modified.
It provides part, scrap, and NCR tracking. Inspection functions are handled in real
time on the shop floor. Part condition, disposition, and job status information is
recorded in the unit configuration.
The Inspection WorkBench provides immediate access to critical information such
as the required tolerances for making repair/reuse decisions. The user can view
on-hand inventory, including allowable part substitutions.
Assembly WorkBench The Assembly WorkBench guides the assembly process. It
includes much of the same functionality as the Inspection WorkBench with some
additions such as checking accumulation status, job/part exchange, validation, and
the recording of installed part and serial numbers. It also provides for
system-guided testing and the creation of a records package.
Access Control WorkBench The Access Control WorkBench is a system
administrator’s tool for controlling workbench access. With it you control a set of
capabilities that are based on functions that can be performed with the
workbenches. Through these capabilities, users are given access to as much or as
little of a workbench as necessary for their jobs. The Access Control Workbench is
also used to set certain system default values such as job and route types.

Extensions to Oracle Applications
A number of Oracle Applications have extended functionality to account for the
increased complexity of the service environment. This new functionality includes
some screens and processes that the standard Oracle Applications do not.
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The following applications have extended functionality:
■

Bills of Material (BOM)

■

Contract Information

■

Costing

■

Inventory

■

Order Entry

■

Purchasing

■

Receiving

■

Shipping

■

Work in Process (WIP)

Bills of Material (BOM) BOM has been modified to accept routes from workbenches
(Unit Configuration, Inspection, Assembly). At job creation, routes are passed from
a workbench through BOM to WIP.
Contract Information The Oracle MRO contract information functionality incorporates
information flowdown. Contract information for specific services is automatically
extracted and attached to WIP jobs and outside purchase orders. Contract
information is made available to subcontractors and sister organizations. Examples
include permissions for rotable inventories, configuration changes, scrap approvals,
approval level, and minimum build goals.
Costing Oracle MRO Costing supports subinventory-level costing. Different
subinventories can have different general ledger accounts set up. Jobs are costed by
actual cost collection, including the addition of outside processing costs. The total
job cost is rolled up by hierarchy to the top job and associated sales order.
Inventory The Oracle MRO Materials Management application identifies life-limited
items and customer time-tracked items. For tracked items, times and cycles can be
recorded. Job picklists are generated automatically. Picking rules can be determined
by the customer, contract, or product. Remarks can be attached automatically based
on rules. Materials Management allows for scrap, rotable, and nonconformance part
management. Inventory information is provided to the workbenches.
Order Entry Oracle MRO Order Entry allows a purchased item to be associated with
a service. It also provides the Unit Configuration WorkBench with the information
required to begin generating a unit configuration. Order Entry allows the recording
of purchased items received for service and the shipping of them after service.
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Purchasing Oracle MRO Purchasing incorporates contract flowdown and allows for
blanket repair agreements and automated remarks.
Receiving Oracle MRO Receiving allows receiving against a purchase order and
receiving against a sales order. In addition, Receiving lets you record information
such as times and cycles for a received item. If the item was received from a vendor,
the services performed on the item can be indicated, and the job associated with the
item can be moved to the next operation. Receiving also has "problem lot" functionality, which notifies buyers of early receipts and over receipts.
Shipping Oracle MRO Shipping allows shipping to an outside vendor for service
without a purchase order. An item can be shipped to a customer from WIP. Item
and serial numbers can be identified after service if necessary. Shipping documents
include more information. In general, MRO Shipping is more flexible than standard
shipping.
Work in Process (WIP) Oracle MRO WIP is the application that represents and
executes the operational plans of the MRO facility. It communicates directly with
the Inspection and Assembly WorkBenches, BOM, Inventory, Costing, and
Purchasing. WIP indirectly relies on the Route Management, Master Configuration,
and Unit Configuration WorkBenches.
MRO WIP departs from normal WIP practices in that the actual job execution is
input from the Inspection and Assembly WorkBenches. Routes are generally created
in the Route Management WorkBench, and can be modified in the shop floor
workbenches. Changes to support functional enhancements include job hierarchies,
out-of-sequence processing, outside processing improvements, the tracking of
part/serial numbers, and multiple part/serial numbers in jobs.

Oracle MRO Processes
The shop floor applications are supported by the rest of the Oracle MRO
applications. Figure 1–2 shows how the Oracle MRO processes relate to one another.
The paragraphs following the figure provide explanations keyed to the circled
numbers on Figure 1–2.
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Figure 1–2 Oracle MRO Processes
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1. The Master Configuration WorkBench is used to convert the IPC information
into an online master configuration that records all possible configurations of a
product. The customer’s established and approved repair procedures are loaded as
routes into the Route Management WorkBench. Index numbers on each online
figure may be linked to one or more routes. Routes are sent to BOM for validating
and archiving.
2. Within customer service functionality, Order Entry maintains contract data that
may include picking rules and scrap management parameters. The picking rules
determine which inventory parts are viewable from the Inspection and Assembly
WorkBenches. The contract, sales order, and receiving functions establish the scope
of work.
3. Creating a unit configuration begins with the retrieval of sales order
information. The unit configuration records the as-received status of the unit,
including times and cycles. (This may also be referred to as the as maintained status.)
The unit configuration also stores the unit’s disassembly and reassembly
configurations.
4. The Inspection and Assembly Workbenches share much functionality and are
shown together for simplicity. The Inspection WorkBench is used to record part and
subassembly conditions, which become the basis for assigning a part to a repair job
or selecting a replacement part. The Assembly WorkBench focuses on parts
accumulation and rollout, part swapping, and assembly and test jobs. The unit
configuration, route, and customer service information determines the appropriate
tasks and operations on the shop floor. Information generated in the Inspection and
Assembly WorkBenches becomes part of the unit configuration.
5. Most jobs are created and executed from the workbenches. These jobs are
dispatched to the Bills of Material and Work in Process applications to verify and
archive the routes and job details. When required, parts are shipped for outside
processing directly from WIP, as executed from the workbenches.
6. The workbenches are integrated with Inventory. Alternate part validity
(according to IPC and customer picking rules) and stock on hand and on order may
be checked from the workbenches. As the job and operation statuses are updated,
inventory is relieved and costs are generated. For outside processing operations,
WIP automatically creates purchase requisitions.
Oracle MRO uses actual costs from the shop floor activities.
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A complex product, such as a jet engine, typically includes a number of models. If
the engine has been in production for a period of time, the models will have
successive engine design generations with configuration differences but still be part
of the same IPC for that engine. Each engine can also have installed options and
upgrades.
The master configuration for an item is the Oracle MRO representation of the
assembly model. The master configuration defines all of the part, alternate part,
reference information, and figure images for all possible configurations as defined
in the IPC. As new part information and service bulletins are applied to the IPC,
new master configurations can be built, or existing master configurations may be
updated.
A master configuration is created with information from multiple sources:
■

■

■

■

Illustrated Parts Catalog electronic files. Text and images on disks or CDs from
the manufacturer.
Illustrated Parts Catalog printed manuals. Text and images scanned from
hardcopy IPCs.
Workbooks created from IPCs to describe particular engine models and
configurations.
Repair manuals from repair and overhaul (R&O) facilities.

The master configuration is the foundation for looking up parts and parts ordering.
The master configuration contains the assembly definitions, referred to as racks, that
define how the product is disassembled for service. Racks are used to define unit
configurations. For each serialized unit, the unit configuration records the installed
assemblies and components, maintenance status, times and cycles, and service
bulletins applied. The unit configuration also stores the unit’s disassembly and
reassembly configurations.
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Figure 1–3 Master and Unit Configurations

Master Configuration

Unit Configurations

Assembly model

Unit-specific information such
as part and serial numbers,
times and cycles, and service
bulletins applied.

Part alternates and
dependencies

Creating a Master Configuration
Creating a master configuration involves the following basic steps:
1.

Prepare the data. Gather, format, and validate the information needed to create
the master configuration. Create the configuration files and rack definitions.

2.

Parse the data. Preparse and parse the configuration files and correct errors.

3.

Add rack definitions. Add rack definitions to the figure information created by
the parser.

4.

Construct the database. Convert the input data into a database.

5.

Map images and create hotspots. Associate image files with the corresponding
figure references in the database. For each image, on each index number that
requires it, create a hotspot linked to the information that defines the indicated
component or the image of the indicated assembly.

6.

Verify the database. Verify the database and figure mapping to confirm that the
inputs are correctly encoded.

7.

Link routes. Link routes with the index numbers on the figures.

Where appropriate, third-party commercial software packages may also be used for
ancillary processes such as scanning and editing images.
This manual uses as examples an aircraft engine.
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2
Getting Started
The following subjects are covered in this chapter:
■

Logging In

■

Timing Out

Getting Started
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Logging In
The Oracle MRO workbenches require a user login sequence. This enables the
permissions associated with the user logging in. Users and their associated
workgroups and roles are created in the Access Control WorkBench.
Perform these steps to log in to the Oracle MRO Master Configuration WorkBench:
1.

From the Windows Start menu, choose Start->Programs->SRP
WorkBench->Master Configuration WorkBench. A login dialog box appears
(Figure 2–1).
Note: Your Windows system may have desktop or Start menu
shortcuts to the Oracle MRO applications. Run the program
according to your setup. Check with your System Administrator if
necessary.

2-2

2.

Type your user login name and password.

3.

Select a workgroup from the list.

4.

Select a role from the list.

5.

Optionally, click Change to change your password. A dialog box appears,
asking you to enter the new password twice.

6.

Click Login. The main workbench window appears.
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Figure 2–1 Master Configuration WorkBench Login Window
.

Table 2–1

Master Configuration WorkBench Login Window Description

Field

Type

Feature

Description

Login

Required

Button

Starts the login process.

Cancel

Optional

Button

Aborts the login and exits the window.

Change

Optional

Button

Changes user password. New
password updates automatically in the
Access Control WorkBench.

User Login Name Required

Field

Login name as defined in Access
Control WorkBench.

Password

Required

Field

Password as defined in Access Control
WorkBench.

WorkGroup

Required

Drop-down list

Of workgroups assigned to user, the
workgroup the user wishes to log in to.

Roles

Required

Drop-down list

Of roles assigned to user, the role
under which user wishes to log in.

Messages

Display only Field

Message field.

Getting Started
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Timing Out
The login process is timed to prevent partially started applications from being on
the network. If you do not complete the login procedure and leave the login
window displayed, the login process automatically terminates after 7 minutes of
inactivity. This value can be changed by the system administrator. Once the
application is fully running, the timeout is disabled.
Thus, if you begin to log in to an application, walk away, and then come back and
don’t see the login window, it is because the timeout terminated the login.
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Preparing the Data
Data preparation is the first step in creating a master configuration database. This
chapter discusses the following topics related to data preparation:
■

Introduction

■

Creating the Files Required for a Master Configuration

■

Defining Racks

■

Creating Figure Image Files
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Introduction

Introduction
Collecting and preparing data is the first step in creating a master configuration.
The input data consists of IPC text, figures, and workbooks. The IPC is annotated
with corrections, comments, and unit configuration specifications and becomes the
official log of the construction process. It is edited to include the latest manufacturer
and local repair shop revisions. It must also be annotated with workbook rack
definitions. This IPC text must be obtained in or converted to ASCII format and
validated. Each IPC figure must be obtained in electronic form or scanned and
saved as an electronic image file.
The annotated IPC and workbooks, electronic ASCII file, and image files are the
records from which a master configuration can be recreated if necessary.
Data preparation involves three primary steps:
1.

Create the files needed for parsing and database construction. These include the
IPC ASCII file and configuration files that describe the format of the IPC.

2.

Create rack definitions. Group assemblies according to the most efficient way
for disassembly and servicing.

3.

Scan, edit, and save the IPC figures with an appropriate naming convention.

This data is used to create a database. Each index on each figure referenced in this
database is then electronically associated with the appropriate image file and a
repair route. Validation and release complete the master configuration, which can
then be used to create the unit configurations used by the Inspection Workbench.

Creating the Files Required for a Master Configuration
The files required to create a master configuration are all simple text files. They can
be created and edited with any word processor or text editor. Table 3–1 describes
these files.
Figure 3–1 shows how the files are used in the process of creating a master
configuration.
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.

Table 3–1
File Name

Files Required to Create a Master Configuration
File Format

Description

IPC ASCII

1

IPC manual in electronic ASCII format.

IPC Format

<name>.ipc

Defines the column format and keywords
used in the IPC manual.

Sets

<root>sets.iff

Defines engine model and options.

Kits ASCII

<root>kits.asc

Kit information from IPC manual in electronic
ASCII format.

<root>eng.asc

The following files are generated automatically by the Master Configuration WorkBench
during the parsing process and are used to create the database. The Figure file is manually
edited to include rack definitions before the database is built. This is discussed in Chapter 4.
Figure

<root>figs.iff

Contains figure information organized by
component. This file is used to map figures to
components according to how the components
are disassembled for service.

Engine

<root>eng.iff

Includes component figure/index and part
information in structured format that can be
read easily by the database builder.

Kits

<root>kits.iff

Defines figure/index and part information for
kits.

1

<root> refers to a prefix defined with the keyword FILENAME_ROOT, described in Table 3–2.

Creating the IPC ASCII File
The master configuration Database Builder application requires as
input a validated, properly indented ASCII format version of the
IPC text. Even if the entire IPC is available as ASCII text, some text
entry and/or scanning is likely to be required to update the file to
match the most current version of the IPC. ASCII data can be
edited in nearly any text editor that can save a file as plain text.

Text Scanning
Small amounts of text missing from the IPC can be entered
manually. If you have large amounts of text to be entered, or if the
entire IPC is available only as a printed manual, scan the text
pages and convert the scanned pages to electronic text using an
optical character recognition (OCR) program.
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Figure 3–1 Creating a Master Configuration
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This scan and OCR task can be performed using any third-party commercial
software packages. Note that OCR systems are not 100% accurate, so scanned text
must be checked for errors. Scanning and converting text is less desirable than
obtaining electronic text directly.

Reviewing the IPC and Checking Compatibility
Regardless of how the ASCII text is obtained, validate it to ensure that all revisions
have been applied to the IPC.
WARNING: Changes to part and alternate part information
should be made only with proper authorization. Do not add or
remove information from the IPC unless the change has been
approved. Annotate all changes to indicate the nature of the
change and who made the change.

As the IPC ASCII files is parsed, the program constructs a Bill of Materials (BOM)
for each engine models in the IPC. To construct the BOM structure, the parser must
understand the complete set of assembly-subassembly relationships for the entire
engine. These relationships are automatically extracted from the manual by using
the indentation system, the forward references, next-higher-assembly references,
and attaching parts.
For parts described in a single figure, the subassembly relationships are indicated
by the Aviation Transportation Association (ATA) indentation conventions. The
parser identifies these breakdowns and attaches the parts to the correct parents in
the BOM assembly hierarchy. However, some assembly breakdowns are spread
across multiple figures or are in different sections or even different chapters. An
assembly may have alternate lists duplicated in different parts of the manual.
During parsing, such subcomponents are collected under the proper parent
assembly in the BOM structure.
Reviewing involves inspecting the text for consistency of these engine
assembly-to-subassembly definitions. This is accomplished by checking the level of
indenture indicated by the dots preceding the nomenclature in the parts listing.
When a part has a note explaining that the detailed breakdown is provided in a
subsequent figure, consistency of part numbers must be checked in the subsequent
description.
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Updating the IPC ASCII File
The IPC ASCII file must be reviewed to determine if the latest manufacturer and
local repair shop revisions are included. As a general rule, a printed IPC may be
taken as the authoritative reference. Any ambiguities must be resolved by
Engineering and QA staff, or possibly by manufacturer representatives.
Three types of inconsistencies may occur with IPC information:
■

Information is in the ASCII file but not in the manual.

■

Information is in the manual but not in the ASCII file.

■

Information in the ASCII file is in error.

Information in File But Not Manual If there is information in the file but not the manual,
and the manual is determined to be correct, comment out (disable) the information
in the file in such a way as to leave a record of the modification, while ensuring that
the data is not included in the database.
1.

Comment out the desired lines by inserting the keyword COMMENT: at the
beginning of each line to be excluded from the database.
Note: The keyword COMMENT: can be changed to any word you
desire for this purpose. Use the GARBAGE_KEY keyword in the
IPC Format file. See "Creating the IPC Format File" on page 3-8.

2.

Insert an additional line or lines before the commented-out lines to describe:
■

What part information was deleted

■

When it was deleted

■

By whom the information was deleted

Refer to the example below.
COMMENT: The next 2 lines of information were removed 10/5/93 L SANDERS
COMMENT: 8-12 6749115-428 .NUT, SLFLKG HEX, THIN, 1/4-28, 550øF ...... ALT R
COMMENT: (SCE CONT FROM 52828 PT NO. JL6S428B)

Information in Manual But Not File Perform the following steps if the information is in
the manual but not in the IPC ASCII file:
1.
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Type the missing part data into the file, making sure that figure/index
references, part number, descriptions, etc. begin in the proper columns.
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2.

Insert an additional line or lines before the new information to describe:
■

Exactly what part information was added

■

When it was added

■

By whom the information was added

Refer to the example below.
COMMENT: The next 1 line of part data was added 10/5/93 L SANDERS
2-1
6809618 NOZZLE ASSY, FUEL SPRAY (SCE CONT FROM.........6

Information in File Is in Error Use the following procedure if the IPC ASCII file
contains incorrect information:
1.

Comment out the desired lines by inserting the keyword COMMENT: at the
beginning of each line to be excluded from the database.

2.

Insert an additional line or lines before the commented-out lines to describe:

3.

4.

■

Exactly what part information was deleted

■

When it was deleted

■

By whom the information was deleted

Insert an additional line or lines before the new information to describe:
■

Exactly what part information was added

■

When it was added

■

By whom the information was added

Insert the new information.
Note: If enough new information is added that the end of the new
information might not be immediately clear, indicate the end with a
line such as "COMMENT: End of new part information."

If the modification is associated with a temporary change or service bulletin,
include a note that identifies the reference. The example below shows incorrect
information removed and new information added.
COMMENT: The next 2 lines of part information were removed 10/5/93 L SANDERS
COMMENT: 8-12
6749115-428 .NUT, SLFLKG HEX, THIN, 1/4-28, 550oF....ALT y R
COMMENT: (SCE CONT FROM 52828 PT NO. JL6S428B)
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COMMENT: The next 1 line of information was added as a result of
COMMENT: O.S. 2J-T56-44S-95 2/9/93
8-12
6749115-428
.NUT, SLFLKG HEX, THIN, 1 / 4 - 28, 550oF ..ALT

Creating the Kits ASCII File
The Kits ASCII file is created in exactly the same way as the IPC ASCII file. The only
difference is that it contains only the information relating to kits.

Creating the IPC Format File
Many of the entries in the IPC Format file define which columns of the IPC manual
contain which information. The IPC Format file identifies the syntax of the IPC
manual. It specifies the range of columns in which various data items appear.
Table 3–2 describes the keywords used in the IPC Format file.
Table 3–2
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IPC Format File Keywords

Keyword

Description

(

Indicates beginning and end of information to be considered by the
parser.

)

PRODUCT:

Describes the product defined by the Illustrated Parts Catalog. The
value for this keyword is what appears in the Engine field
drop-down list used in the Master Configuration, Unit
Configuration, Inspection, and Assembly WorkBenches. The values
for PRODUCT, IPC MANUAL, IPC REVISION, and VERSION
become the names the folders created by the parser in the main
master configuration folder.

FORMAT:

Tells the parser in what format the ASCII file is written.

FILENAME_ROOT:

Root of the parser file names, four characters maximum.

IPC MANUAL:

Identifies the document number of the IPC manual. The values for
PRODUCT, IPC MANUAL, IPC REVISION, and VERSION become
the names the folders created by the parser in the main master
configuration folder.

IPC REVISION:

Identifies the number of the IPC manual revision (a certain revision
date). The values for PRODUCT, IPC MANUAL, IPC REVISION,
and VERSION become the names the folders created by the parser in
the main master configuration folder.
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Table 3–2 (Continued) IPC Format File Keywords
Keyword

Description

VERSION:

Distinguishes between multiple master configuration database
builds based on the same IPC manual revision. The values for
PRODUCT, IPC MANUAL, IPC REVISION, and VERSION become
the names the folders created by the parser in the main master
configuration folder.

CHAP_SEC_START:

Column in which chapter/section/unit indication begins.

CHAP_SEC_END:

Column in which chapter/section/unit indication ends.

REV_START:

Column in which revision indication begins.

REV_END:

Column in which revision indication ends.

FIG_INX_START:

Column in which figure/index data begins.

FIG_INX_END:

Column in which figure/index data ends.

NUM_START:

Column in which part number begins.

NUM_END:

Column in which part number ends.

NOM_START:

Column in which nomenclature begins.

NOM_END:

Column in which nomenclature ends.

UPA_START:

Column in which units per assembly begins.

UPA_END:

Column in which units per assembly ends.

UON_START:

Column in which use-on code begins.

UON_END:

Column in which use-on code ends.

CONT_FILL:

Column in which a part data continuation line begins.

GARBAGE_KEYS:

Number of GARBAGE_KEY phrases defined. Words preceded by
GARAE are ignored when determining IPC information.

GARBAGE_KEY:

Phrase to be ignored by parser. Line containing word specified with
this keyword should not be used to deduce IPC information.
Prevents parser from reading information such as header and footer
lines, comments, and deleted material.

MANUALS:

Number of MANUAL_ATTACH phrases defined.

MANUAL_ATTACH: A MANUAL_ATTACH phrase tells the parser to create a parentchild relationship between two IPC indexes, as follows:
Parent

Child

MANUAL_ATTACH: Ch-SecUnit-Fig-Index;Ch-SecUnit-Fig-Index
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Figure 3–2 shows an example of an IPC file. Column positions for these definitions
are given in spaces from the left margin and begin with 0. Note that the keyword
COMMENT is defined with the GARBAGE_KEY keyword. Also note the use of
MANUAL_ATTACH phrases.
Figure 3–2 IPC Format File
(
PRODUCT: CF34-BJ
FORMAT: GE
FILENAME_ROOT: CF34
IPC MANUAL:
SEI779
IPC REVISION:
1
VERSION:
1
CHAP_SEC_START: 70
CHAP_SEC_END: 78
REV_START:
0
REV_END:
1
FIG_INX_START: 2
FIG_INX_END:
11
NUM_START:
12
NUM_END:
28
NOM_START:
29
NOM_END:
68
UON_START:
69
UON_END:
76
UPA_START:
77
UPA_END:
80
CONT_FILL:
32
GARBAGE_KEYS: 6
GARBAGE_KEY: COMMENT:
GARBAGE_KEY: ILLUSTRATED
GARBAGE_KEY: FIGURE
GARBAGE_KEY: Fig.
GARBAGE_KEY: Mar
GARBAGE_KEY: Page
MANUALS: 2
MANUAL_ATTACH: 72-00-1-1;72-22-1-1
MANUAL_ATTACH: 72-00-1--10;72-23-1-1
)
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Perform the following steps to create the IPC Format file:
1.

Use a word processor or text editor to create a new file.
Note: If you are using a word processor, select a monospace font
such as Courier so that the words align properly.

2.

Enter the contents of the file according to the keyword definitions (Table 3–2)
following a sample such as Figure 3–2. You may also copy text from an existing
IPC Format file or edit a copy of an existing file.

3.

Save the file as a text file but with the extension .ipc instead of .txt.

w

Note: If you are using a word processor that can save files in a
number of formats, you should select "Text" for the document type
when you save. The program may want to assign a file extension of
.txt. If this happens, just reenter the extension as .ipc.

Creating the Sets File
The Sets file is used to map the model definitions to the values of the use-on codes
in the IPC. Table 3–3 describes the keywords used in the Sets file.
Table 3–3

Sets File Keywords

Keyword

Description

(

Beginning and end of information to be considered by the
parser

)

NAME:

Describes what is being defined.

PAIRS:

Number of INDEX and VALUE pairs in file.

INDEX:

Character or number assigned to use on code in IPC.

VALUE:

Value of INDEX, as defined in IPC. Appears as a selection in
fields of the Oracle MRO workbenches.

Figure 3–3 shows part of the IPC file for the General Electric CF34 engine, which has
two models. In the IPC, the use-on codes A and B are assigned to these engine
models. These same index values are used in the Sets file (Figure 3–4). The values
specified for these indexes become the options available in the Model drop-down
list when creating a unit configuration.
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Figure 3–3 IPC File Designation for CF34 Engine Models

72-00-00
ILLUSTRATED PARTS CATALOG
FIG ITEM PART NUMBER
1

1 6078T27G01
- 1A 6089T11G01

DESCRIPTION

UOC

ENGINE ASSEMBLY-CF34-3A1
ENGINE ASSEMBLY-CF34-3B1

A
B

QTY
1
1

Figure 3–4 Sets File and Result in Unit Configuration WorkBench
.

(
NAME: ENGINE MODEL
PAIRS: 2
INDEX: A
VALUE: CF34-3A1
INDEX: B
VALUE: CF34-3B
)

Perform the following steps to create the Sets file:
1.

Use a word processor or text editor to create a new file.
Note: If you are using a word processor, select a monospace font
such as Courier so that the words align properly.

2.

Enter the contents of the file according to the keyword definitions (Table 3–3)
following a sample such as Figure 3–4. You may also copy text from an existing
Sets file or edit a copy of an existing file.

3.

Save the file as a text file but with the extension .iff instead of .txt and the name
in this format:
<FILENAME_ROOT>sets.iff
where <FILENAME_ROOT> is the value for that keyword.
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Note: If you are using a word processor that can save files in a
number of formats, you should select "Text" for the document type
when you save. The program may want to assign a file extension of
.txt. If this happens, just reenter the extension as .iff.

Defining Racks
The most efficient disassembly and assembly procedures often require that parts
shown in a single engineering figure be separated into different groups. These
groups are called racks, which is a reference to the large carts often used to transport
assemblies and subassemblies to repair areas.
Because repair shops work with different engines and have different resources
available, they divide their operations differently. For example, one shop might
have areas for welding, heating, and cleaning that service all engine components.
Another shop might organize areas by assembly, not by operation. The shop might
have areas for compressors, fans, and gearboxes. Because of this diversity, Oracle
MRO lets you create different rack definitions from the same IPC data.
In the Oracle MRO system, a rack is defined by a set of figures and index numbers.
The manner in which parts are serviced in a shop is indicated by the way figures are
assigned to racks in the master configuration.
A figure may be included in multiple racks, as happens with the higher level
components such as the turbine and compressor. For example, some parts in a
figure are inspected as part of the compressor, and others are inspected as part of
the turbine. Some are not inspected at all. A figure may be included in more than
one rack, but each index number on a figure is included in only one rack. When you
are reviewing figures to create rack definitions, you must determine which parts are
to be inspected as part of which rack.
Parts that are not inspected are assigned to auxiliary racks. An auxiliary rack is a rack
used to account for unused figures or uninspected parts. For example, any indexes
in the COMPRESSOR section of the IPC that are not inspected can be assigned to a
rack with a name such as UNINSPECTED COMPRESSOR PARTS. Auxiliary racks
are discussed in detail in "Adding Rack Definitions to the Figure File" in Chapter 4.
Perform these steps to create rack definitions:
1.

For each workbook, compare the figures with the latest IPC figures. Annotate
each IPC figure to reference the appropriate workbook. The index numbers on
each figure must be identified as included for inspection in the current
workbook or in some other workbook.
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2.

If figures are included in multiple places, add all workbook names to each copy
of the figure. This allows information to be cross-checked across workbooks.

3.

Compile a list of definitions as each of the workbook figures is reviewed.
Record the following information for each figure:
■

IPC figure name

■

Full IPC figure number (chapter, section, unit, figure)

■

■

Rack name: an assembly name such as turbine or compressor, or an
auxiliary rack name
Figure indexes to be inspected as part of each rack

This information is integrated into the Figure file after the parsing stage. When the
Master Configuration Database Builder reads the Figure file, it extracts the rack
information and builds the rack definitions into the database.
To change the rack definitions, you must change how racks are defined in the
Figure file, and then build another master configuration database.
The Master Configuration Database Builder is discussed in Chapter 4.

Creating Figure Image Files
Figures that exist only in a printed IPC must be scanned to create an electronic
image file for incorporation into the master configuration. You must have an image
scanner to scan the figures. You must also have a graphics application to receive the
image data from the scanner, edit the image as necessary, and save it as a standard
bitmap image file with the extension .bmp.
There are many suitable scanners and graphics packages available. Image quality is
important. You’ll need to experiment some with scanning parameters such as
brightness and contrast to obtain the sharpest images.
Perform the following steps to create scanned image files:
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1.

Scan each page containing a figure you want to include.

2.

Perform any necessary image cleanup or editing:
a.

Using a graphics application, remove the figure number and title. They are
not necessary on the figure itself because they will appear in the title bar of
the workbench windows.

b.

Remove other extra marks such as marks where binder holes were
punched, the page was folded, and notes were written.
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Note: The final image cannot be larger than 620 x 620 pixels.
3.

Save the image file in the .bmp image format. Use a file naming convention that
makes it easy to associate an image file with its IPC figure reference. That is, the
image file name should indicate, for example, the chapter, section, unit, figure,
and sheet number.
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Parsing, Building, and Figure Mapping
Once the input data has been prepared and validated, the next step is to construct
the database and map figures. This chapter discusses the following topics:
■

Introduction

■

Using the Database Builder

■

Preparsing

■

Parsing

■

Adding Rack Definitions to the Figure File

■

Building the Engine and Figure Database

■

Using the Picture Book

■

Using the Picture Book

■

Using the Tree Browser

■

Mapping Figures

■

Creating and Editing Hotspots

Parsing, Building, and Figure Mapping
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Introduction

Introduction
The IPC and Kits ASCII files are preparsed to quickly check for simple errors. They
are then parsed to produce the Engine file (<root>eng.iff), Kits file (<root>kits.iff),
and Figure file (<root>figs.iff). Parsing also produces some status files.
The parser automatically detects the endpoints of all the assembly-to-subassembly
relationships and writes them into the Engine and Kits files. Also included is
alternativity data for each figure/index accompanied by the notes, restrictions, and
service bulletin references for each part.
The parser writes the figure information into the Figure file. Rack definitions are
inserted into this file to associate the figure references with the scanned image files.
The Master Configuration WorkBench uses the Figure and Engine files to build a
database.Selectable links are created between the index numbers on figures and the
relevant part information in the database, which may be specific part information or
a link to another figure.
The Master Configuration WorkBench consists of two primary programs, accessed
with the buttons on the main Master Configuration WorkBench window
(Figure 4–1):
■

■
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The Database Builder is used to preparse, parse, and build the database.
The Picture Book is used to link the figure references and part data in the
database with the appropriate image files and figure index numbers on those
images. It is also used to link index numbers to routes.
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Figure 4–1 Master Configuration WorkBench Window

Using the Database Builder
To preparse, parse, and build the database, use the Database Builder program
(Figure 4–2). Table 4–1 describes the menus and menu items available in this
window.
Figure 4–2 Master Configuration Database Builder
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Table 4–1

Master Configuration Database Builder Menus

Menu

Submenu/Command Description

File

Open

Displays dialog box used to choose the IPC Format
file.

Exit

Exits the Database Builder application back to
main Master Configuration WorkBench window.

Preparse

Starts preparse of IPC ASCII file that checks for
basic errors and incorrect indentation dot sequence
(for example, 1 dot to 3 dots in consecutive lines).

Parse

Parses the ASCII text file. Produces the Figure file,
Engine file, and Kits file (optional). The Figure file
must be edited to include rack definitions.

Build Assy

Builds the database from the Figure, Engine, and
Kits files.

Check Assy

Checks the database for errors. If Status->File is
chosen, information is written to a file called
<root>assy.txt.

Rebuild

Not implemented.

Settings

Displays the IPC manual, IPC revision, and version
of the master configuration. This information is
used by the Database Builder to create the file
structure in which the master configuration data is
stored. These parameters, recorded in the IPC
Format file, become part of the name of the master
configuration.

Module >

Includes or excludes an engine and/or kits from
the parse or build.

IPC

Options

Engine

Includes engine in preparse, parse, and build.

Kits

Includes kits in preparse, parse, and build.

Status

Window

4-4

Information about the status of the preparse, parse
or build is displayed in a window or recorded in a
file created in the same directory as the IPC Format
file. The prefix <root> in the file names below is
defined by FILENAME_ROOT keyword statement
in the IPC Format file.
Shows status information and error messages in
the program window.
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Table 4–1 (Continued) Master Configuration Database Builder Menus
Menu

Submenu/Command Description
File

Writes status information and error messages to a
file created in the same directory as the IPC Format
file. The prefix <root> in the file names below is
defined by FILENAME_ROOT keyword statement
in the IPC Format file.
For a parse, the file created is <root>parse.txt.
For a build, the file created is <root>build.txt.
For an assembly check, the file created is
<root>assy.txt.

Off
Preparse >

Status information is not recorded or displayed.
Defines the checks performed by the preparse
function.

Attaching Parts

Checks attaching parts for beginning and end tags:
ATTACHING PARTS and ***.

Partial
Breakdown

Not implemented.

Open Nodes

Not implemented.

Parens

Checks for missing parentheses. Parentheses must
occur in pairs in the form (text).

Sub Level

Checks for indenture consistency. For example, a
line preceded with 3 dots cannot follow a line
preceded by 1 dot.

Units Per Assy

Checks that there is an entry in the units per
assembly column.

Preparsing
Preparsing quickly scans the text of the IPC and Kits ASCII files to identify simple
problems such as typographical errors and problems with the beginning or end of
attaching parts listings. The IPC parser executes the preparsing process in a few
minutes and generates error messages. The information is displayed on the screen
or saved to a log file, depending on the option selected.
Perform the following steps to preparse the master configuration files:
1.

Choose File->Open to display the open dialog box and choose an IPC Format
file to open.
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Note: Valid IPC Format files have the file name extension .ipc.
Once a file is open, the name appears in the window header and
the menu commands become active.
2.

From the Options menu, define the parameters for the preparse and status
tracking functions. See Table 4–1 for a description of the menu items.

3.

Choose IPC->Preparse.
a.

If no errors are found, the preparse process is complete.

b.

If errors are found, messages appear in the window or are written to the
<root>prep.txt file.
Note: Attaching parts should begin with a line containing only the
phrase ATTACHING PARTS. The set is terminated by a line
containing the string ***. If either of these tags is missing, the
preparser does not know where the list begins or ends, depending
on the error. The preparser detects when either tag is missing and
identifies the region of the file.

4.

Correct errors as necessary in the IPC ASCII and/or Kits ASCII files. When you
are finished, choose IPC->Preparse again. Repeat until the preparse completes
successfully.

Parsing
The parsing process generates structured files of part and figure data: the Engine,
Kits, and Figure files. Status files are also produced.
Parsing takes several minutes, depending on the size of the files and speed of the
computer. The parser reads the IPC ASCII and Kits files and constructs the part
hierarchy. During this process some validation occurs that was not possible in the
preparsing stage.
Perform these steps to parse the master configuration files:
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1.

On the main Master Configuration window, click Build Database.

2.

Choose File->Open to display the open dialog and choose an IPC Format file
to open.
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Valid IPC files have t

Note: Valid IPC Format files have the file name extension .ipc.
Once a file is open, the name appears in the window header, and
the menu items become active.
3.

From the Options menu, choose the items that apply. See Table 4–1 for a
description of the menu items.

4.

Choose IPC->Parse.
Note: If parsing has been performed previously, an Engine and
Figure file already exist. In this case, you are asked if you want to
keep the existing files. If the existing Figure file contains rack
definitions that you want to keep, click Yes and back up your
Figure file before overwriting it.
a.

If the process completes without errors, parsing is complete.

b.

If errors are found, messages appear in the program window or are logged
to files created by the parser.
The information in the log files is useful to determine why a parse did not
complete successfully. See "Status Files Produced by the Parser" for
information about these files.

5.

Correct errors as necessary in the IPC ASCII, IPC Format, Sets, or Kits ASCII
files.

6.

When you are finished, choose IPC->Parse again. Repeat until the parse
completes successfully.

Status Files Produced by the Parser
The parser creates status files and writes information to them during the parse. The
information in these files is useful for troubleshooting the parse process.
The status files are created in the directory that contains the IPC ASCII, Kits ASCII,
IPC Format, and Sets files. Two files always produced: <root>misc.txt and
<root>garb.txt. The <root>parse.txt file is produced if Options->Status->File is
chosen. The prefix <root> in the file names is defined by the FILENAME_ROOT
keyword statement in the IPC Format file.
Lines that cannot be parsed are copied into the <root>misc.txt file.
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Lines that were not parsed because of the use of the GARBAGE_KEY keyword are
copied to <root>garb.txt file.
Status and error messages generated during the process are written to the
<root>parse.txt file.

Engine File
Parsing restructures the IPC information to create a file that is easy for the Database
Builder to work with. The Engine file contains all the assembly-to-subassembly
relationships and alternativity data for each figure/index, accompanied by the
notes, restrictions, and service bulletin references for each part relative to the engine
component. Figure 4–3 shows part of an Engine file.
Note: The section and unit information in the IPC ASCII file are
combined into the section information in the Engine file.
Figure 4–3 Engine File (Partial)
(
chapter:
section:
figure:
index:
part_num:
nomenclature:
num_notes:
units_per:
on_code:
sub_level:
sub_dots:
attach_p:
revised_p:
att_indices:

72
00
1
1
6078T27G01
ENGINE ASSEMBLY-CF34
0
1
A
0
0
0
(A, B)

)

Kits File
The Kits file contains all the information on any manufacturer’s repair kits that
apply to the engine. It is structured the same as the Engine file.
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Adding Rack Definitions to the Figure File
The Figure file is generated automatically during the parsing process. Before the
Master Configuration database is built, the Figure file must be manually edited to
include the rack definitions. Each index must be included in one, and only one,
rack.

Figure File Keyword Definitions
The following keywords may be used to define a figure. The first six keywords are
generated by the parser. The last two can be added manually to further define racks.
Table 4–2

Figure File Keywords

Keyword

Description

(

Defines the beginning and end of the specification of a figure
reference.

)

CHAPTER:

Two-digit chapter number. (Use 00 if the IPC manual is not ATA
standard format.)
This keyword is generated automatically by the parser.

SECTION:

Two-digit section number. (Use 00 if the IPC manual is not ATA
standard format.)
This keyword is generated automatically by the parser. Includes
unit information.

FIGURE:

Figure number as indicated in the IPC (for example, 25, 35A).
This keyword is generated automatically by the parser.

NAME:

Exact figure title from the IPC (single line).
This keyword is generated automatically by the parser.

ATT_INDICES:

Attribute indices. Identify the engine models or component
options applicable to this figure, as defined in the Sets file.
This keyword is generated automatically by the parser.

MAIN_COMPONENT:

Names a component and indicates that all indexes for the figure
are to be included for inspection. By default, MAIN_
COMPONENT: ENGINE is assigned to each figure reference
during parsing.
This keyword is generated automatically by the parser.
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Table 4–2 (Continued) Figure File Keywords
Keyword

Description

SUB_COMPONENT:

Names a component and indexes to be inspected as part of a
rack other than the one specified with MAIN_COMPONENT:
for that figure. See Figure 4–5 for an example. A figure may have
more than one SUB_COMPONENT: statement.
This keyword is added manually by editing the Figure file.

COMPONENT:

Names components and index ranges in sheets beyond first one
when a figure spans multiple sheets. See Figure 4–5 for an
example. A figure may have more than one COMPONENT:
statement.
If no indexes or range is indicated, the default is all indexes.
This keyword is added manually by editing the Figure file.

Editing the Figure File
Use the following procedure to add rack definitions to the Figure file:
1.

Open the Figure file in a word processor or text editor.

2.

For each figure, indicate the rack to which it belongs by editing the
MAIN_COMPONENT: keyword statement.
Note: When creating the Figure file, the parser assigns the
keyword statement MAIN_COMPONENT: ENGINE to each figure.
Change ENGINE to the appropriate rack.
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3.

If the figure includes indexes that should be inspected as part of another rack,
specify the rack and indexes with a SUB_COMPONENT: statement. A figure
may have more than one SUB_COMPONENT: statement. Specifying multiple
components for a figure includes the figure in multiple racks.

4.

If the figure includes components and/or indexes that are not inspected, assign
them to an auxiliary rack. See "Auxiliary Racks" on page 4-14.

5.

If a figure spans multiple sheets:
a.

Specify the rack on sheet 1 with a MAIN_COMPONENT: statement.

b.

Use the COMPONENT: keyword to assign subsequent sheets to racks. the
same rack as sheet 1.
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Note: A figure may have more than one COMPONENT:
statement. Specifying multiple components for a figure includes the
figure in multiple racks. Additional racks to which the figure is
assigned must be defined somewhere in the Figure file with a
MAIN_COMPONENT: statement.
c.

Specify subsequent sheets of the figure as a different rack by using the
MAIN_COMPONENT: keyword again with a different name.

6.

Repeat steps 1 through 5 for each figure in the Figure file.

7.

When you are finished, save the file as a text file.

8.

Create a backup of the Figure file.
Caution: If you run the parser again, a new Figure file is created
that overwrites the existing one and its rack definitions. You lose all
your definitions. It is important to keep a backup of your Figure file
with rack definitions.

Figure 4–4 shows part of a Figure file as created by the parser, before rack
definitions are added. Figure 4–5 shows the same part of the Figure file after rack
definitions are added. (The rack definitions are in bold for clarity.) Each figure is
mapped to one or more engine components, or racks. Engine component names are
preceded by the keyword MAIN_COMPONENT:, SUB_COMPONENT:, or
COMPONENT:. Using these keywords to specify a component includes the figure
in the rack definition for that component name. Specifying multiple components for
a figure includes the figure in multiple racks. In Figure 4–5, Figure 5 is a member of
two racks (compressor and turbine).
The component names appearing in the Figure file become the racks that can be
selected in the Unit Configuration, Inspection, and Assembly WorkBenches.
Although any names can be used for components, it is recommended that standard
rack definitions be used for all master configurations.
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Figure 4–4 Figure File Before Rack Definitions Are Added
SECTION: 00
FIGURE: 1
NAME: FIGURE 1. ENGINE
ATT_INDICES: (A, B, C, D)
MAIN_COMPONENT: ENGINE
)
(
CHAPTER: 72
SECTION: 1
FIGURE: 1
NAME: FIGURE 1. ENGINE ASSEMBLY
ATT_INDICES: (A, B, C,D)
MAIN_COMPONENT: ENGINE
)
(
CHAPTER: 72
SECTION: 1
FIGURE: 2
NAME: FIGURE 2. POWER UNIT ASSY
ATT_INDICES: (A, B, C,D)
MAIN_COMPONENT: ENGINE
)
(
CHAPTER: 72
SECTION: 1
FIGURE: 3
NAME: FIGURE 3. TURBOPROP POWER
ATT_INDICES: (A, B, C,D)
MAIN_COMPONENT: ENGINE
)
(
CHAPTER: 72
SECTION: 1
FIGURE: 4
NAME: FIGURE 4. TURBOPROP POWER
ATT_INDICES: (A, B, C,D)
MAIN_COMPONENT: ENGINE
)
(
CHAPTER: 72
SECTION: 1
FIGURE: 5
NAME: FIGURE 5. TURBOPROP POWER
ATT_INDICES: (A, B, C,D)
MAIN_COMPONENT: ENGINE
)
(
CHAPTER: 72
SECTION: 1
FIGURE: 5
NAME: FIGURE 5. TURBOPROP POWER
ATT_INDICES: (A, B, C,D)
MAIN_COMPONENT: ENGINE
)
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By default, each figure is assigned
to the engine rack. Each figure must
have a main component to which all
indexes are assigned.

The values assigned to engine
models in the Sets file appear here
as the values for the
ATT_INDICES: keyword.

SECTION ASSY (ACCESSORY DRIVE HOUSING & EXTERNAL OIL PUMP)

SECTION ASSY (TURBINE SCAVENGE PUMP & COMPRESSOR TIE BOLT)

SECTION ASSY (EXTERNAL OIL PIPING) (501-D22) (SHEET 1 OF 3)

When a figure is spread across
multiple sheets, a Figure file entry
is created for each sheet.
SECTION ASSY (EXTERNAL OIL PIPING) (501-D22) (SHEET 2 OF 3)
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Figure 4–5 Figure File After Rack Definitions Are Added
(
CHAPTER: 00
SECTION: 00
FIGURE: 1
NAME: FIGURE 1. ENGINE
ATT_INDICES: (A, B, C,D)
MAIN_COMPONENT: ENGINE

If chapter and section do not
apply, use the value 00.

)
(
CHAPTER: 72
SECTION: 1
FIGURE: 1
NAME: FIGURE 1. ENGINE ASSEMBLY
ATT_INDICES: (A, B, C,D)
MAIN_COMPONENT: COMPRESSOR
SUB_COMPONENT: UNINSPECTED ENGINE PARTS, 1:2,

Assign indexes for items not inspected
as part of this main component to an
auxiliary rack. An auxiliary rack is one
to which unused figures and
uninspected parts are assigned.

)
(
CHAPTER: 72
SECTION: 1
FIGURE: 2
NAME: FIGURE 2. POWER UNIT ASSY
ATT_INDICES: (A, B, C,D)
MAIN_COMPONENT: UNINSPECTED ENGINE PARTS

Figure 2 is not inspected, so it is
assigned to the UNINSPECTED
ENGINE PARTS auxiliary rack.

)
(
CHAPTER: 72
SECTION: 1
FIGURE: 3
NAME: FIGURE 3. TURBOPROP POWER SECTION ASSY (ACCESSORY DRIVE HOUSING & EXTERNAL OIL PUMP)
ATT_INDICES: (A, B, C,D)
MAIN_COMPONENT: COMPRESSOR
)
(
CHAPTER: 72
SECTION: 1
FIGURE: 4
NAME: FIGURE 4. TURBOPROP POWER SECTION ASSY (TURBINE SCAVENGE PUMP & COMPRESSOR TIE BOLT)
ATT_INDICES: (A, B, C,D)
MAIN_COMPONENT: TURBINE
SUB_COMPONENT: UNINSPECTED ENGINE PARTS, 31, 33:34,
)
(

Indexes can be indicated
singly or as a range.
CHAPTER: 72
SECTION: 1
FIGURE: 5
NAME: FIGURE 5. TURBOPROP POWER SECTION ASSY (EXTERNAL OIL PIPING) (501-D22) (SHEET 1 OF 3)
ATT_INDICES: (A, B, C,D)
MAIN_COMPONENT: COMPRESSOR
Figures can continue over
SUB_COMPONENT: TURBINE, 41, 49:50, 52,

)
(

multiple sheets with multiple
components.

CHAPTER: 72
SECTION: 1
FIGURE: 5
NAME: FIGURE 5. TURBOPROP POWER SECTION ASSY (EXTERNAL OIL PIPING) (501-D22) (SHEET 2 OF 3)
ATT_INDICES: (A, B, C,D)
COMPONENT: COMPRESSOR
COMPONENT: TURBINE
)
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Auxiliary Racks
The number of racks defined in the Figure file may not account for all of the figures
in the IPC, because some figures are not used in the inspection workbooks. In
addition, some figures have parts that do not require inspection. To account for
these situations, create auxiliary racks to which unused figures or uninspected parts
can be assigned.
Derive the name of an auxiliary rack from the IPC section name in which the figure
is found. However, do not use the same name as one of the primary racks. Modify
the existing rack name so the auxiliary rack has a name that is similar to the
primary rack and indicates the purpose of the auxiliary rack; for example,
UNINSPECTED ENGINE PARTS for ENGINE. Any figures in the ENGINE section
of the IPC that are not required in the engine rack can be assigned to
UNINSPECTED ENGINE PARTS. The same can be done for specific index numbers
within a figure. In Figure 4–5 in the second CHAPTER block, indexes 1 and 2 are
assigned to the auxiliary rack UNINSPECTED ENGINE PARTS. When the
Inspection WorkBench displays this figure as part of the compressor rack, no
hotspots appear for index numbers 1 and 2. These index numbers are not
inspectable as part of the compressor.
Some parts have entries in a figure section of the manual, but have no index
number. If such a part falls between parts in a component range already specified in
the Figure file, it is placed with the same component. If it needs to be included in a
different component, edit the IPC text. Insert the COMPONENT: keyword after the
part along with the value of the desired component.

Building the Engine and Figure Database
After the rack definitions have been added to the Figure file, the database can be
built.
Perform the following steps to build the master configuration database file:
1.

Choose File->Open and choose an IPC Format file to open. Valid IPC files have
the file name extension .ipc. Once you’ve opened a file, the file name appears in
the screen header area, and the IPC menu items become active.
Note: If the IPC Format file was previously opened for preparsing
or parsing and has not changed, you do not need to open it again.

4-14

Oracle Maintenance, Repair and Overhaul Master Configuration WorkBench User’s Guide

Using the Picture Book

2.

Choose Options->Module->Engine and/or Options->Module->Kits. See
Table 4–1 for a description of the menu items.

3.

Choose Options->Status and Window, File, or Off.

4.

Choose IPC->Build Assy.
■

■

If the process completes without errors, the database build is complete.
If errors are found, messages are written to the window or to the
<root>debug.iff file.

5.

Correct errors as necessary in the IPC ASCII, Engine, Kits, or Figure file.

6.

When you are finished, choose IPC->Build Assy.

7.

Choose File->Exit to return to the main workbench window.

8.

Use the Tree Browser to verify the structure of the IPC database. See "Using the
Tree Browser" on page 4-18.

Status Files Produced by the Database Builder
The Database Builder creates status files and writes information to them during the
build. The information in these files is useful for troubleshooting the build process.
The status files are created in the directory that contains the IPC ASCII, Kits ASCII,
IPC Format, and Sets files. One file is always produced: <root>debug.iff. The
<root>build.txt file is produced if Options->Status->File is chosen.
Status messages regarding how the build is handling figure references written to the
<root>debug.iff file.
Status messages generated part by part regarding the build process are written to
the <root>build.txt file.
The prefix <root> in the file names is defined by the FILENAME_ROOT keyword
statement in the IPC Format file.

Using the Picture Book
The Picture Book is used to link the figure references and part data in the database
with the appropriate image files and figure indexes. It is also used to verify the
master configuration and link index hotspots with routes.
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On the Master Configuration window, click Picture Book to start the Picture Book
(Figure 4–6). All of the Picture Book functions are available from the fields and
buttons on the toolbar. Table 4–3 describes the elements in this window.
Figure 4–6 Master Configuration Picture Book
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Table 4–3
Field Name

Picture Book Description
Type

Feature

Description

Engine

Optional

Drop-down list

Selects the master configuration to be
worked on.

Rack

Optional

Drop-down-list

Selects the rack to be defined.

Optional

Button

Exit. Exits the Picture Book application
and returns to main MCWB window.

Optional

Button

Figure Mapper. Used to create
associations between figure image files
and the figure references in the
database.

Optional

Button

Hotspot. Used to define and move
figure hotspots.

Optional

Button

Export. Creates a backup file of the
hotspot definitions, including screen
location, default disposition, serial
numbers, and route associations.

Optional

Button

Import. Restores hotspots from a
backup file to a rebuilt database.

Optional

Button

Verify. Verifies that the figure, hotspot,
part, and alternate part information in
the master configuration database is
correctly encoded. Steps sequentially
through each figure for systematic
verification of data. Also verifies master
configuration parts against parts in the
item master used by Oracle
applications.

Optional

Button

Dump. Exports a text file of IPC
information to be used for verification.

Optional

Button

Search. Allows searching and
navigating of the master configuration
on part number, ATA reference, IIN,
and router ID and type.
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Table 4–3 (Continued) Picture Book Description
Field Name

Type

Feature

Description

Optional

Buttons

Back and Forward. Displays images in
the order they were viewed. For
example, if you from an image to a
linked image and then another, Back
takes you back through the same
images

Optional

Buttons

Next Image and Previous Image.
Displays image files sequentially, like
paging through a book.

Once a part displayed in the window has a hotspot defined, you can right-click it to
display a shortcut menu (Figure 4–6). A number of functions can be initiated from a
hotspot. Table 4–4 describes the shortcut menu commands.
Table 4–4

Picture Book Shortcut Menu

Menu Command

Description

Hotspot Information

Displays Hotspot Specifications window.

Delete Hotspot

Deletes hotspot.

Not implemented.
Detailed
Measurements Builder

Link Routes

Displays Link Routes window, which used to associate routes
with a hotspot. Linking routes is discussed in Chapter 6.

Tree Browser

Displays the IPC information in a hierarchical tree structure.

Navigate

Displays figure linked to the figure displayed. presence of linked
figure is indicated by boxed hotspot.

Using the Tree Browser
The tree browser allows you to display the master configuration IPC database in a
hierarchical directory structure that can be expanded and collapsed for convenient
viewing. This can be useful for verifying that the parser and Database Builder
correctly interpreted the IPC ASCII file. Items whose proper place could not be
determined from the IPC are placed at the top level, making them easy to find in the
Tree Browser. Once the proper location of items is determined, specify it with a
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MANUAL_ATTACH phrase in the IPC Format file. See "Creating the IPC Format
File" on page 3-8.
Perform the following steps to use the Tree Browser:
1.

Right-click a hotspot and choose Tree Browser from the shortcut menu. The
Tree Browser appears (Figure 4–7). Initially, the window is empty.

2.

Choose View->Whole Tree to view the entire IPC hierarchy, or choose
View->Current Sub Tree to view the IPC at and below the level of the hotspot
from which the Tree Browser was launched.

Note: In the Tree Browser, the number that precedes the part
number is a reference number assigned by the system when it reads
IPC structure.
3.

To expand a level, click on the + next to a folder. Once a folder is expanded, the
+ changes to a -.

4.

To contract a list, click on the - next to a folder. The - changes to a +.

5.

Choose File->Save to save an ASCII text flat file of the IPC (Figure 4–8). When
you name the file, include an extension that allows you to open the file easily in
the text processor you will use to view the file.

6.

Choose File->Close to exit the window.
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Figure 4–7 Tree Browser

Table 4–5

Tree Browser Menu

Menu Command

Description

File
Save

Saves all Tree Browser IPC information in a flat file format. Use
the .txt extension with file name.

Close

Closes the Tree Browser.

View
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Whole Tree

Displays entire IPC information in a hierarchical directory
structure.

Current Sub Tree

Displays the IPC information at and below the level of the
hotspot from which the tree browser was launched.
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Figure 4–8 IPC Flat File Made from Tree Browser (Partial)
UNIT: 1,
level=1:
level=2:
level=3:
level=3:
level=3:
level=3:
level=3:
level=3:
level=3:
level=3:
level=3:
level=4:

(34-1--1) CF34
currNodeId=12, parentNodeId=1, 6078T27G01, 72-00-1-1, ENGINE ASSEMBLY-CF34-3A1
currNodeId=13, parentNodeId=12, 6087T08G01, 72-00-1-10, MODULE ASSEMBLY-FAN
currNodeId=45, parentNodeId=13, 1023T04P01, 72-0001-1-5, PLATE-ID-MODULE
currNodeId=46, parentNodeId=13, 3020T52P04, 72-0001-1-10, RING-RETAINING
currNodeId=47, parentNodeId=13, 3022T18G01, 72-0001-1-15, WASHER-KEY
currNodeId=49, parentNodeId=13, AS3217-223, 72-0001-1-25, RING-RETAINING
currNodeId=50, parentNodeId=13, 4096T34P01, 72-0001-1-30, WASHER-NO.1 BEARING KEY
currNodeId=51, parentNodeId=13, 5071T37P01, 72-0001-1-35, LOCKNUT-NO.1 BEARING
currNodeId=52, parentNodeId=13, 6078T35P02, 72-0001-1-40, BEARING-NO.1 BALL
currNodeId=53, parentNodeId=13, 5071T33P01, 72-0001-1-45, RUNNER-NO.1 SEAL
currNodeId=54, parentNodeId=13, 6078T83G01, 72-21-5-1, ROTOR ASSEMBLY-FAN
currNodeId=586, parentNodeId=54, 4029T51P04, 72-21-5-10, .NUT-SELF-LOCKING

Mapping Figures
Use the Figure Mapper to map figure references and define, save, and restore
hotspots. Figure image files must be associated (mapped) to the figure references
before hotspots can be defined or the routes can be linked. If a figure spans multiple
sheets, each sheet is considered a figure reference that must be mapped
Perform the following steps to map image files to figure references:
1.

From the main Master Configuration window, click Picture Book.

2.

Click the Map button on the toolbar. The Figure Mapper appears (Figure 4–9).
See Table 4–6 for a description of the fields in the window.

3.

In the IPCs Associated with this Workgroup field, choose the master
configuration for which you want to map figures.

4.

Use the Figure Image Directory list to locate the directory of the IPC image files.
When you do, the image files appear in the Figure Image File list.

5.

Map an image file to its figure reference:
a.

Choose a figure name in the Figure Image File list.

b.

Choose a figure reference name in the Unmapped Figures list.

c.

Click Map. The figure reference is deleted from the list. The figure reference
and image file name appear together as a new line in the Mapped Figures
list. Note that the Mapped Figures list shows the complete name of the
figure and the complete path to the image file.
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6.

To correct an incorrectly mapped figure, choose the figure in the Mapped
Figures list and click UnMap. The figure reference reappears in the Unmapped
Figures list.

7.

Choose the figure name in the Unmapped Figures list, and then choose the
proper image file.

8.

Continue this process until no figure names remain in the Unmapped Figures
list.

Figure 4–9 Figure Mapper
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Table 4–6

Figure Mapper Window Description

Field Name

Type

Feature

Description

IPCs Associated
with this
WorkGroup

Optional

Drop-down list

Master configurations available for use
with the Figure Mapper.

Mapper/Close

Optional

Button

Accepts changes and exits window.

Image File Path

Display only Field

Path to image files as selected in Figure
Image Dir list.

Figure Image Dir

Optional

List

Directory containing figure image files.

Figure Image File

List

Image files.

Unmapped
Figures

List

Figure references in the database that
have not been mapped to an image file.

Mapped Figures

List

Figure references and image files to
which they are mapped.

Figures Region Buttons
Map

Optional

Button

Associates selected image file with the
selected figure reference.

UnMap

Optional

Button

Removes association of selected image
file with the selected figure reference.

UnMap All

Optional

Button

Unmaps all image file-figure reference
associations.

Creating and Editing Hotspots
After figure images and references are mapped, create hotspots. This process creates
a link between an index number on the screen and the data associated with the
index number in the database. This data includes information such as the part,
alternate parts, notes, restrictions, service bulletins, serial numbers, and use-on
codes.
Note: Hotspots are assigned to a unit configuration at the time the
unit configuration is derived from the master configuration.
Changes to a hotspot cannot be applied to previously existing unit
configurations.
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Creating Hotspots
Perform the following steps to create a hotspot:
1.

On the main Master Configuration window, click Picture Book. The Master
Configuration window appears (Figure 4–6).

2.

Choose a master configuration from the Engine field.

3.

Choose a rack from the Rack field.

4.

Use the Next Image and Previous Image arrows to locate the figure on which
you want to create hotspots.

5.

Click the Hotspot button. The cursor changes to a pointer with crosshair.

6.

Click an index number in the image, or wherever a hotspot is desired. The
Hotspot Specifier appears (Figure 4–10). See Table 4–7 for a description of the
fields in the window.

7.

Enter the index number of the referenced part (usually the one just clicked).

8.

Select or clear the Visible on Screen check box.
Note: If Visible on Screen is not selected, the hotspot does not
appear, but the information associated with the hotspot can still be
accessed with the search function. See Chapter 7.

9.

Enter the industry index number (optional).

10. Enter the billing code (optional).
11. Choose an inspection type. The inspection type is used when making a

disposition on the part in the Inspection WorkBench.
12. Indicate if the part is 100% replaceable.

Note: Parts that are designated 100% replaceable are scrapped
automatically when the Inspection WorkBench is used during the
disposition and inspection process. You cannot change this
disposition in the Inspection WorkBench.
13. Indicate if the part is serialized and time tracked. If Serialized and Time-Tracked

are selected here, when the part is dispositioned, the inspector is prompted to
enter the appropriate data before a job is created.
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14. Click OK when you are finished, and the following events occur:
■

■

■

The hotspot is registered into the database and linked to the data for this
figure-index number combination.
If Visible on Screen is selected, the program places the index number
specified over the number in the original image. If the component being
registered is itself a subassembly, the index number is enclosed in a box,
and a hyperlink is constructed to the subassembly figure.
If the Master Configuration WorkBench finds no matching index number in
the database, a dialog box appears that states the hotspot was not created.

15. Click the Hotspot button again to exit the Hotspot Specifier. The crosshair

cursor is replaced by the pointer, indicating you have exited the Hotspot
Specifier.

Material Requirements for 100% Replaceable Parts
Material requirements for accumulation jobs are created from parts dispositioned
during the inspection, repair, and assembly process; and from parts designated in
the master configuration as being 100% replaceable.
Parts that are designated 100% replaceable are assigned a scrap disposition
automatically in the Inspection WorkBench, which is used during the disposition,
inspection, and repair processes. You cannot change this disposition in the
Inspection WorkBench.
To create a materials requirement for these parts, a Bill of Materials must be created
in Oracle Applications for each accumulation route linked to an assembly that
contains 100% replaceable parts. When the accumulation job is created, the 100%
replaceable parts automatically become material requirements for the accumulation
job. If the 100% replaceable items are not to be accumulated, then attach the BOM to
the assembly route.
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Figure 4–10 Hotspot Specifier Window
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Table 4–7

Hotspot Specifier Window Description

Field Name

Type

Feature

Description

Hotspot Index

Required

Field

Index number that was selected to
bring up the Hotspot Specifier.

Visible on Screen

Optional

Check box

Determines whether or not a hotspot is
visible on screen. Information
associated with a hotspot that is not
visible is available through the IPC
search function.

Industry Index
Number

Optional

Field

Standard industry number assigned to
life-limited and time-tracked parts that
the FAA dictates must be tracked.

Billing Code

Optional

Field

Billing code number for hierarchical
cost rollup scheme.

Inspection Type Region
Standard Replace
From Floor Stock

Optional

Radio button

Not implemented.

Standard Replace
From Inventory

Optional

Radio button

Not implemented.

Standard Replace
From Kit

Optional

Radio button

Not implemented.

Visual Inspection
Only

Optional

Radio button

Not implemented.

Detailed
Measurement
Requirement

Optional

Radio button

Not implemented.

Check box

Part is always replaced, regardless of
condition. Selecting 100% replaceable
prevents the part from being assigned
another disposition in the Inspection
WorkBench.

Optional

Radio button

Not known if part is serialized or not
serialized.

Non-Serialized

Optional

Radio button

Part is not serialized.

Serialized

Optional

Radio button

Part is serialized.

Time-Tracked

Optional

Check box

Part is serialized and time in service is
also is also tracked.

Inspection Option Region
100% Replaceable Optional

Part Properties Region
Unknown
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Table 4–7 (Continued) Hotspot Specifier Window Description
Field Name

Type

Feature

Description

OK

Optional

Button

Accepts input and exits window.

Cancel

Optional

Button

Rejects input and exits window.

Editing Hotspots
Once a hotspot is defined, whenever the pointer is placed over this hotspot, the
cursor changes to a hand symbol to indicate that you are in the active region. You
can now move the hotspot with the left button or display a menu with the right
button.

Moving a Hotspot
Perform these steps to move a hotspot:
1.

Put the cursor on the hotspot to be moved. The pointer changes to a hand.

2.

Press and hold the left button, and drag the hotspot to a new location. Release
the button.

Deleting a Hotspot
Perform these steps to delete a hotspot:
1.

Put the cursor over a hotspot. The pointer changes to a hand. Right-click to
display the menu.

2.

Choose Delete Hotspot from the menu.

Editing Hotspot Specifications
Perform these steps to edit hotspot information:
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1.

Put the cursor over a hotspot. The pointer changes to a hand. Right-click to
display the menu.

2.

Choose Hotspot Information from the menu to bring up the Hotspot
Specifications window (Figure 4–11). Table 4–8 describes the fields in the
window.

3.

Edit the part properties, inspection type, and inspection option as required.

4.

Click OK to exit the window.
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Editing Part Information
Perform these steps to add or delete parts to a master configuration or edit part
information:
1.

Put the cursor over a hotspot. The pointer changes to a hand. Right-click to
display the menu,

2.

Choose Hotspot Information from the menu to bring up the Hotspot
Specifications window.

To delete a part from the Part Alternates list:
3.

Choose the part in the list and click the Delete Part button.

To edit the information of a part in the Part Alternates list:
4.

Double-click the part in the list. The Edit Part Information window appears
(Figure 4–12). Table 4–9 describes the fields in the window.

5.

Edit the part information as required and click OK to return to the Hotspot
Specifications window.

To add a new part to the Part Alternates list:
6.

Click the New Part button. The Edit Part Information window appears
(Figure 4–12).

7.

Enter the part information as required and click OK to return to the Hotspot
Specifications window.

8.

On the Hotspot Specifications window, click OK to exit the window.
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Figure 4–11 Hotspot Specifications Window
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Table 4–8

Hotspot Specifications Window Description

Field Name

Type

Feature

Description

Hotspot Information Region
Chapter

Display only Field

Chapter number.

Section

Display only Field

Section and unit number.

Figure

Display only Field

Figure number.

Item

Display only Field

Index number.

Industry Index
Number (IIN)

Optional

Field

Industry number that indicates the part
type.

Billing Code

Required

Field

Billing code number for hierarchical
cost rollup scheme.

Navigatable

Display only Check box

Visible

Optional

Indicates if the hotspot can be
navigated

Check box

Assembly Information Region
Assembly Index

Display only Field

Reference number assigned by tree
browser when building the IPC
structure.

Assembly Name

Display only Field

IPC nomenclature.

Number of Alts

Display only Field

Number of valid alternate parts.

Parts Properties Region
Unknown

Optional

Radio button

Not known if part is serialized or not
serialized.

Non-Serialized

Optional

Radio button

Part is not serialized.

Serialized

Optional

Radio button

Part is serialized.

Time-Tracked

Optional

Check box

Part is serialized and time in service is
also is also tracked.

Inspection Type Region
Standard Replace
From Floor Stock

Optional

Radio button

Not implemented.

Standard Replace
From Inventory

Optional

Radio button

Not implemented.

Standard Replace
From Kit

Optional

Radio button

Not implemented.

Visual Inspection
Only

Optional

Radio button

Not implemented.
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Table 4–8 (Continued) Hotspot Specifications Window Description
Field Name

Type

Feature

Description

Detailed
Measurements
Requirement

Optional

Radio button

Not implemented.

Check box

Part is always replaced, regardless of
condition. Selecting 100% replaceable
prevents the part from being assigned
another disposition in the Inspection or
Assembly WorkBenches.

Inspection Option Region
100% Replaceable Optional

Part Alternates Region
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Part
Number/Part
name

Display only List

Acceptable alternate parts or
assemblies for the component indicated
with the index number.

Add Part

Optional

Button

Displays the Edit Part Information
window, which is used to make
changes to the part information or to
add a new part.

Delete Part

Optional

Button

Deletes the selected part from the list of
parts associated with the index.

OK

Optional

Button

Accepts input and exits window.

Cancel

Optional

Button

Rejects input and exits window.
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Figure 4–12 Edit Part Information Window

Table 4–9

Edit Part Information Window Description

Field Name

Type

Feature

Description

Part Number

Required

Field

IPC part number.

Part Name

Required

Field

IPC part name.

Use On Code

Optional

Field

IPC use-on code (UOC). Both global
(capital letters) and local (lowercase
letters) use-on codes are recognized.

Units Per
Assembly

Required

Field

IPC units per assembly (UPA). May
also indicate that the part is an alternate
(ALT) or that the information can be
obtained from a reference (REF).

Notes

Required

Field

Notes relating to part being edited or
added.

OK

Optional

Button

Accepts input and exits window.

Cancel

Optional

Button

Rejects input and exits window.

Saving Hotspot Information
It is common to rebuild a master configuration database to correct errors. For this
reason, hotspot information can be saved into a separate file, so it is not lost should
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the database be rebuilt. This allows mapped-figure and linked-route associations to
be restored without having to redo the work.
Perform the following steps to save hotspot information:
1.

Click the Save Hotspot button.

2.

Click OK in the dialog box that appears. The Select Hotspot Dump File window
appears. This is a standard Windows file dialog box. Specify the directory and
file name for the file to which the figure mapping and route information is
written.

3.

Click Open. A summary of the data to be saved appears.

4.

If this meets with your approval, click OK. The information is saved to the file
you specified. When the backup is complete the hotspot saver reports back the
counts of figures and hotspots.

5.

Click OK to return to the main window.

6.

Make a backup copy of the saved hotspot file.

Restoring Hotspot Information
Master configuration files may need to be reparsed to correct errors or to
incorporate updates. Rebuilding the database creates a new IPC part database that
does not include the figure mapping and route information. The figure mapping
and route information can be restored from the backup file.
Note: If figures are restored with the wrong path, you must remap
all the figures. See "Mapping Figures" on page 4-21.

Perform the following steps to restore hotspot information:
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1.

On the main Picture Book window, click the Restore button. The Restore
Hotspots and Figure Maps window appears (Figure 4–13). Table 4–10 describes
the fields in the window.

2.

In the IPCs Associated with this Workgroup field, choose the master
configuration for which you want to perform a restore.

3.

Use the Hotspot Directory and Hotspot File windows to locate the hotspot save
file.

4.

In the Restore field, choose one or both of the options:
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■

■

5.

Choose Restore Bitmap Paths to restore the figure mappings from the
preceding saved hotspots.
Choose Restore Hotspots and Routes to restore the hotspot and route
information.

Click Start Restore. The hotspot file is read, and the information is added to the
database. The Status field shows the progress as the database is updated.
If Restore Bitmap Paths is selected, the Mapped Figures window shows the
restored figure mappings as progress is made in the mapping.
If the database contains new figures, they are not mapped or recorded in the
hotspot file. Unmapped figures appear in the Unmapped Figures list. Map these
figures to the new image files and define hotspots for them. See "Mapping
Figures" on page 4-21.
Note: After certain changes to the database, errors may be
encountered when hotspots are restored. For example, an index
may have been deleted, making the hotspot information invalid. A
status message alerts you to the location of the problem.

6.

Click OK to exit the window.
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Figure 4–13 Restore Hotspots and Figure Maps Window

Table 4–10

Restore Hotspots and Figure Maps Window Description

Field Name

Type

Feature

Description

IPCs Associated
with this
WorkGroup

Optional

Drop-down list

Master configuration to have hotspots
restored.

Current Version
Only

Optional

Check box

Inactive.

Restore Bitmap
Paths

Optional

Check box

Restores associations between locations
of the image files and hotspots.

Restore Hotspots
and Routes

Optional

Check box

Restores hotspot information, including
window location and association with
routers.

Start Restore

Optional

Button

Starts the restore process.

Restore Region
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Table 4–10 (Continued) Restore Hotspots and Figure Maps Window Description
Field Name

Type

Feature

Status

Display only Field

Shows status of restore process as it
progresses.

OK

Optional

Accepts changes and exits window.

Hotspot File

Display only Field

Shows path to hotspot file once it has
been located with the Hotspot Dir and
Hotspot File fields.

Hotspot Dir

Optional

List

Used to navigate to directory
containing the hotspot file.

Hotspot File

Selectable

List

List of files.

Unmapped
Figure Names

Selectable

List

List of figure references in the database
that are not been mapped to an image
file.

Mapped Figures

Selectable

List

List of figure references and image files
to which they are mapped.

Button

Description
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Verifying the Database
This chapter provides information on the following topics:
■

Introduction

■

Verifying the Master Configuration Database

■

Comparing the Master Configuration to the Item Master

Verifying the Database
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Introduction

Introduction
A final phase of generating the master configuration is verifying the database
information to ensure that it has been properly encoded. This verification phase
requires an understanding of the engine and IPC structure.
The task involves visually checking that parts, alternates, notes, and references are
properly associated with the correct engine components. Figure images must be
validated against the database figure references, and hotspots must be checked
against the figure index data. When verification is complete, routes are mapped,
and the working database is copied to the designated database server for release to
the floor.
A further verification is to compare the IPC information in the master configuration
with the item master database in Oracle Applications.

Verifying the Master Configuration Database
The Verify function incrementally steps through the entire database, starting with
Figure 1, index 1 of the first chapter. You designate each line as OK or BAD, and a
log is generated that captures the verification results. After validation is complete,
you can review the log file to see what mistakes were found.
Perform the following steps to verify the master configuration database:
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1.

On the main Master Configuration WorkBench window, click Picture Book.

2.

In the Engine field, select the engine whose IPC you want to validate.

3.

Click the Verify button on the toolbar. The Verify Catalog window appears
(Figure 5–1). See Table 5–1 for a description of the fields in the window.

4.

In the Log File region of the screen, click New Verify Log to begin the
validation process, or click Open Verify Log to continue a validation that was
stopped before completion. A standard Windows file dialog box appears in
which you can specify the name and location of the log file.

5.

Name or select the log file. Note that a log file should have the extension .log.
Click Open. The Verify Catalog window shows the complete log file path and
the chapter, section, figure and index number of the first figure in the database.
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Note: The Master Configuration WorkBench combines IPC unit
number with the section number. Section numbers appear with
extra digits to show this. A section number of four digits such as
2011, for example, indicates section 20, unit 11.
6.

Click Start Verification or Restart. The Verify Catalog screen shows the chapter,
section, figure, and index from the database. The part information list now
shows the part name, nomenclature, notes, units per assembly, and use on
codes for the displayed index.

7.

Verify if the information is correct.
a.

If the information is correct, click OK/Go Next, and the next line appears.

b.

If the information is incorrect, click BAD/Go Next, and the next line
appears.

8.

When you are finished, or want to stop and resume later, click Close Verify
Log. The verify log is saved. You can continue from this point at a later time by
opening the file and clicking Restart.

9.

Click Done to exit the window.

Verifying the Database
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Figure 5–1 Verify Catalog Window

Table 5–1

Verify Catalog Window Description

Field Name

Type

Feature

Description

Optional

Button

Closes the verification log file.

Open Verify Log Optional

Button

Opens the verification log file.

Log File Region
Close Verify Log

Verify Region
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Start Verification

Optional

Button

Retrieves the database information and
displays the first line below.

Select
Figure/Index

Optional

Button

Not implemented.

Compare to Item
Master

Optional

Button

Compares the item master dump file
with the master configuration dump file.

Done

Required

Button

Exits the window.

Print

Optional

Button

Not implemented.

Oracle Maintenance, Repair and Overhaul Master Configuration WorkBench User’s Guide

Comparing the Master Configuration to the Item Master

Table 5–1 (Continued) Verify Catalog Window Description
Field Name

Type

Feature

Description

File Information Region
Verify File

Display only Field

Path to and name of the verification file.

Chapter/Section
/Figure/Index

Display only Fields

Database information for the displayed
part.

OK/Go Next

Optional

Button

Displays next line in database.

BAD/Go next

Optional

Button

In the verify log, flags the line as having
an error by placing the word BAD by it.

Database Information Region
Part Number

Display only List

Part number.

Nomenclature

Display only List

Part name.

UPA

Display only List

Units per assembly.

Comparing the Master Configuration to the Item Master
The inventory item master in Oracle Applications can be saved as a flat file. This
information can be compared with a flat file of the information in the master
configuration database.
Perform the following steps to compare the part numbers in the master
configuration database with the item master database:
1.

Create an item master flat file:
a.

Log onto the database containing the item master.

b.

Enter the following SQL code statements:
$ sqlplus inv/inv@mydb
SQL> setpagesize 0
SQL> set linesize 20
SQL> spool itemmaster.txt
SQL> select segment1 from mtl_system_items order by 1 ;
....
SQL> spool off
SQL> exit
$

A text file named itemmaster.txt is created in the current directory.

Verifying the Database
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2.

5-6

Create a Master Configuration Database flat file:
a.

On the main Master Configuration WorkBench window, click Picture Book.

b.

In the Engine drop-down list, select the master configuration you wish to
verify against the item master.

c.

Click the Dump button. Specify a file name and path for the flat file.

d.

Click Save to create the file, or write into an existing file.

3.

Click the Verify button on the toolbar. The Verify Catalog window appears.

4.

Click Compare to Item Master. The Compare the Dump Files window appears
(Figure 5–2). Table 5–2 describes the fields in the window.

5.

Enter, or browse to, the master configuration dump file, item master file, and
the output file that will contain the results of the comparison. Note that these
are text files.

6.

Click Start Compare to begin the comparison. All the part numbers in the
master configuration that were not found in the item master appear in the
Status region of the window.

7.

When the process has completed, you can open and review the output file.
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Figure 5–2 Compare the Dump Files Window
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Table 5–2
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Compare the Dump Files Window Description

Field Name

Type

Feature

Description

Path of the Master
Configuration
Dump File

Optional

Field

Path to and name of the local dump
file.

Path of the Item
Master File

Optional

Field

Path to and name of the item master
dump file.

Path of the
Output File

Optional

Field

Path to and name of the comparison file
that is generated.

Browse

Optional

Button

Displays standard Windows file dialog
used to locate files.

Status

Display only Report

Shows the results of the file
comparison.

Start Compare

Optional

Button

Starts the comparison process.

Close

Required

Button

Exits the window.
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Linking Index Numbers with Routes
This chapter contains information on the following topics:
■

Introduction

■

Linking Index Numbers with Routes

■

Saving and Restoring Linked-Route Information

Linking Index Numbers with Routes
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Introduction
The Route Management WorkBench creates and manages routes, the procedures
used to disassemble, clean, inspect, repair, and test the assemblies of a product.
Routes contain not only procedures but also information about such things as the
level of service and type of task. A route also identifies the department and
resources required to perform the procedure and the alternate parts that can be
used.
Routes are associated with a product by linking them to the product’s master
configuration at the figure index number where the route applies. This association
allows the Unit Configuration WorkBench access to all the required information to
create a complete plan with resource and material requirements for a specified level
of service.
Accumulation routes are linked to the master configuration at all figure indexes
where accumulation takes place. For example, if parts accumulation is to occur for
the compressor, then in the master configuration, an accumulation route is linked to
the figure index at the highest level for the compressor. More than one
accumulation route may be linked to an index. An assembly route should be linked
to each index that has an accumulation route linked to it. This is because
accumulation and assembly jobs must be created at the same level in the unit.
Different accumulation configurations can be setup by using the service types with
the routes. For example, one set of accumulation routes may be created with a
minor overhaul service type and linked to various indexes in the master
configuration. Another set of accumulation routes may be created with a major
overhaul service type and linked to different indexes.
A Bill of Material should be created for each accumulation route for an assembly
that contains 100% replaceable parts. The requirements for these parts comes from
the BOM associated with the accumulation route. When the accumulation job is
created, the 100% replaceable parts automatically become material requirements for
the accumulation job. If the 100% replaceable items are not to be accumulated, then
the BOM is attached to the assembly job.
Associating index numbers with routes is done with the Picture Book program in
the Master Configuration WorkBench.
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Linking Index Numbers with Routes
Perform the following steps to link an index number with a route or routes:
1.

From the main Master Configuration window, click Picture Book. The Master
Configuration Picture Book appears.

2.

Choose a master configuration.

3.

Choose a rack.

4.

Use the Next Image and Previous Image arrows to locate the figure on which
you want to link routes.

5.

Right-click a hotspot and choose Link Routes. The Link Routes window
appears (Figure 6–1). See Table 6–1 for a description of all the fields on this
window.

6.

Click Show Routes to expand the screen to show the Filter region and available
routes.

7.

Filter the routes shown by making selections in the Product, Lable1, Lable2,
Route Type, and Service Type fields. As choices are made, the list of routes is
reduced to those that meet all the filter conditions.

8.

Choose a route or routes, and then click Link Selected Routes to associate the
routes with the index number (chapter, section/unit, figure, index reference).
The routes immediately appear in the Linked Route region.
Note: In the Picture Book, indexes to which routes are linked
appear gray.

9.

To view the details of a route in the Linked Route region, choose the route and
click Route Details. The Route View window appears (Figure ). Table 6–2
describes the fields in the window. Click Close to exit the window.

10. To disassociate a route or routes with the index number, choose the route in the

Linked Routes region and click Unlink Routes.

Linking Index Numbers with Routes
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Figure 6–1 Link Routes Window

Table 6–1

Link Routes Window Description

Field Name

Type

Feature

Description

Assembly Node Details Region
Name

Display only Field

IPC nomenclature of indexed part.

Chapter

Display only Field

Chapter from IPC manual.

Figure

Display only Field

Figure from IPC manual.

Section

Display only Field

Section and unit from IPC manual.

Index

Display only Field

Index number from which Link Routes
was selected.

OK

Optional

Accepts window as defined and exits.

Button

Cancel
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Rejects any changes and exits window.

Unlink Routes

Optional

Button

Unlinks route selected in Linked
Routes region.

Route Details

Optional

Button

Shows route Details window.
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Table 6–1 (Continued) Link Routes Window Description
Field Name

Type

Feature

Description

Show Routes

Optional

Button

Expands window to show Filter region
and available routes.

Linked Routes Region
Route ID

Display only Selectable

Route number.

Rev

Display only Field

Route revision level.

Route Description Display only Field

Route description.

Planner ID

Display only List

Name of person who defined route.

Service Type

Display only List

Type of service.

Product

Optional

Drop-down list

Product.

Lable1

Optional

Drop-down list

Additional product identifier.

Lable2

Optional

Drop-down list

Additional product identifier.

Route Type

Optional

Drop-down list

Route type as specified in the Topic
Group file.

Service Type

Optional

Drop-down list

Service types as defined in Route
Management WorkBench.

Link Selected
Routes

Optional

Button

Links route selected under Filters
region to assembly shown. Route name
moves to Linked Routes region.

Select All

Optional

Button

Selects all routes.

Deselect All

Optional

Button

Deselects all routes.

Refresh

Optional

Button

Checks route database and refreshes
display of released routes.

List of Released
Routes

Display only List

Filter Region

Released routes that meet the filter
conditions.

Linking Index Numbers with Routes
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Figure 6–2 Route View Window
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Table 6–2

Route View Window Description

Field Name

Type

Feature

Description

Route ID

Display only Field

Route identification number.

Description

Display only Field

Name of route.

Item ID

Display only Field

Inventory to which route is tied.

Planner ID

Display only Field

Name of person who defined route.

Org Code

Display only Field

Organization code.

Route Type

Display only Field

Type of route.

Service Type

Display only Field

Type of service.

Revision

Display only Field

Revision level of route.

Status

Display only Field

Route status.

Product

Display only Field

Product.

Label1

Display only Field

Additional product identifier.

Lable2

Display only Field

Additional product identifier.

Effective date

Display only Field

Date route became effective.

Inactive Date

Display only Field

Date route become inactive.

Operations Region
Seq.

Display only Field

Order in which step is performed.

Description

Display only Field

Operation name and steps.

Department

Display only List

Department responsible for performing
the operation.

Auth Required

Display only List

Indicates if and by whom
authorization is required.

Mandatory

Display only List

Indicates if the operation is mandatory.

Close

Required

Exits window.

Button

Linking Index Numbers with Routes
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Saving and Restoring Linked-Route Information
The information associated with a hotspot can be saved into a separate file so that it
is not lost should the database be rebuilt. This allows hotspot information, figure
mapping, and route linking data to be restored without having to redo the work.
Figure numbers, hotspots, and routes are saved together, but may be restored
separately.
To save and restore index-route linking information, refer to these procedures:
"Saving Hotspot Information" on page 4-33 in Chapter 4.
"Restoring Hotspot Information" on page 4-34 in Chapter 4.
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Searching and Navigating
This chapter provides information on the following topics:
■

Introduction

■

Searching and Navigating a Master Configuration

Searching and Navigating
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Introduction

Introduction
The search function lets you quickly locate master configuration information. You
can navigate to the figure containing the index linked to an ATA reference. From the
search results list, you can display and select commands from the same shortcut
menu that is available from a hotspot on a figure.
Searches may be done based on the following criteria:
■

ATA reference (chapter, section, unit, figure, index)

■

Nomenclature

■

Rack

■

Part number

■

INN (industry index number)

■

Route ID and/or route type

Searching and Navigating a Master Configuration
Perform the following steps to search and navigate in a master configuration:
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1.

From the main Master Configuration window, click Picture Book.

2.

Click the Search button on the toolbar. The IPC Search Criteria window appears
(Figure 7–1). See Table 7–1 for a description of the fields in the window.

3.

Enter your search criteria. Note that a search returns results even if you do not
enter complete information.

4.

Click Find. A status message appears saying the database is being queried.
When the search is done, the IPC Search Results window appears (Figure 7–2).
See Table 7–2 for a description of the menus in this window.

5.

From the View menu choose view and sort commands to arrange your data
according to your needs.

6.

In the all-items view, you can take action on the hotspot associated with a line
by selecting the line, right-clicking, and choosing a command from the shortcut
menu. This is the same menu that appears in the Picture Book.
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Note: In the all-items view, indexes for which hotspots are defined
appear in bold type. Indexes that do not have a hotspot appear in
regular type.
7.

In the IPC Search Criteria window, click Clear to remove your search criteria
and perform another search. Click Cancel to close the window.

Figure 7–1 IPC Search Criteria Window

Searching and Navigating
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Table 7–1

IPC Search Criteria Window Description

Field Name

Type

Feature

Description

ATA Reference Region

7-4

Chapter

Optional

Field

Chapter from IPC manual.

Section

Optional

Field

Section from IPC manual.

Unit

Optional

Field

Unit from IPC manual.

Figure

Optional

Field

Figure number from IPC manual.

Item

Optional

Field

Index number on figure.

Nomenclature

Optional

Field

Nomenclature from IPC.

Rack

Optional

Field

Rack in unit configuration.

Part number

Optional

Field

IPC part number.

Route ID

Optional

Field

Route ID.

Route Type

Optional

Drop-down list

Route type.

Job ID and Type

Optional

Drop-down list

Inactive in Master Configuration
WorkBench. Applies only to Inspection
and Assembly WorkBenches.

Find

Optional

Button

Begins database query.

Clear

Optional

Button

Clears all fields of the IPC Search
Criteria window.

Cancel

Optional

Button

Closes the window.

Oracle Maintenance, Repair and Overhaul Master Configuration WorkBench User’s Guide

Searching and Navigating a Master Configuration

Figure 7–2 IPC Search Results Window
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Table 7–2

IPC Search Results Window Menu Commands

Menu Command

Description

File Menu
Save

Inactive.

Print

Inactive.

Exit

Closes the window.

View Menu
All Items View

Displays all IPC items.

Hotspot Items View

Displays only IPC items for which hotspots are defined.

Non-Hotspot Items View Displays only IPC items for which hotspots are not defined.
Linked Routes View

Displays only IPC items with hotspots to which routes are
linked and displays information about the routes (route type, ID,
status, description, planner).

Columns

Toggles on and off the display of the Nomenclature column and
Route Description column.

Sort By

Sorts displayed data by ATA reference, nomenclature, or route
type, ID, status, description, or planner.

Shortcut Menu
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Define Hotspot

Displays Picture Book with the Hotspot function active. Click
where you want to define a hotspot.

Hotspot Information

Displays the Hotspot Specifications window for the selected
index.

Delete Hotspot

Deletes the hotspot for the selected index.

Link Routes

Displays the Link Routes window, which is used to associate
route with hotspot. Linking routes is discussed in Chapter 6.
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Creating New Master Configurations
This chapter provides information on the following topics:
■

Introduction

■

Creating Versions of a Master Configuration

■

Dealing with Changes to a Master Configuration

Creating New Master Configurations
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Introduction

Introduction
New master configurations must be created to account for changes to figure
references, rack definitions, and some part data. Some types of changes may require
you to reparse and rebuild the database. Other changes may require only updating
with the Picture Book program. However, some changes to an existing master
configuration should not be made because they invalidate all unit configurations
based on the master configuration. To deal with these changes, you must create a
new master configuration. Subsequent unit configuration are created from the new
master configuration.
The only master configuration changes that are accessible to existing unit
configurations are changes to the route or routes linked to an index number and
changes to part information, including associating a new part number with an
existing index number.

Creating Versions of a Master Configuration
If the new master configuration is based on the same IPC revision, simply create a
new version of the master configuration. If the new master configuration is to be
built on a new revision of the IPC, you must edit the attribute that defines the IPC
revision in the IPC Format file. To account for other types of changes, refer to
Table 8–1. See the references at the end of this chapter for detailed procedures
covering the actions in the general steps that follow.
Perform these steps to build another master configuration from the same IPC data:

8-2

1.

Create a new folder in the folder that contains the files used to build a master
configuration. Name this folder to indicate the version of the master
configuration.

2.

Into this folder place copies of the IPC ASCII, IPC format, IPC Sets, and Hotspot
files. If you want to preserve all or most of the existing rack definitions, also
copy the Engine and Figure files.

3.

In the IPC Format file, change the attributes as necessary for PRODUCT:, IPC
MANUAL:, IPC REVISION:, and VERSION:.

4.

Edit the Figure file if necessary to change rack definitions.

5.

Rebuild the database.

6.

Restore the hotspots, figure mapping, and linked-route information from the
Hotspot file.

7.

Edit the hotspots if necessary.
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Dealing with Changes to a Master Configuration
How much of the procedure for creating a master configuration needs to be done
depends on the changes being made. In Table 8–1, find the change you want to
make in the first column, and then read across the row to see what steps you need
to take to create a new master configuration.
WARNING: Changes to part and alternate part information
should be made only with proper authorization. Do not add or
remove information from the IPC unless the change has been
approved. Annotate all changes to indicate the nature of the
change and who made the change.

Table 8–1

Creating a New Master Configuration
1

2

3

4

6

7

8

MASTER
CONFIG.
CHANGE

STEP

Edit IPC
ASCII file

Parse

Edit Figure
file

Build/ Map
verify figures

Edit/save
hotspots

Restore
hotspots

Link routes

Add figure to
IPC*

Yes.
Yes. Save
Indicate
existing
changes
Figure file.
with
comments.

Yes. Add
figure to
rack.

Yes

Yes. Map
new figure
to image
file.

Yes. Create
hotspots for
new figure.
Save
hotspots.

Yes. Restore
hotspots,
image paths,
and routers.

Yes. Link
index
numbers on
new figure
to routes.

Yes.
Yes. Save
Indicate
existing
changes
Figure file.
with
comments.

Yes. Remove
references to
removed
figure.

Yes

Yes.
Unmap
figure to be
removed.

Yes. Delete
hotspots on
image of
removed
figure. Save
hotspots.

Yes

No

Add figure
index to IPC

Yes.
Yes. Save
Indicate
existing
changes
Figure file.
with
comments.

Use backup
Yes
Figure file.
Edit only if
index is
assigned to
rack different
from rest of
figure.

Yes, if new
image file
added. No
if not.

Yes. Create
hotspot for
new index.
Save
hotspots.

Yes

Yes. Link
new index
to route.

Remove figure
index from IPC*

Yes.
Yes. Save
Indicate
existing
changes
Figure file.
with
comments.

Use backup
Yes
Figure file.
Edit only if
index was
assigned to
rack different
from rest of
figure.

No

Yes. Remove
hotspot for
deleted
index. Save
hotspots.

Yes

No

*Must also add
new image file.
Remove figure
from IPC*
*Do steps in this
order: 6, 5 1, 2,
3, 4, 7

*Do steps in this
order: 6, 1, 2, 3,
4, 5, 7

5
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Table 8–1 (Continued) Creating a New Master Configuration
STEP

1

2

3

4

MASTER
CONFIG.
CHANGE

Edit IPC
ASCII file

Parse

Edit Figure
file

Update image
file*

No

No

No

Link index to
new route

5

6

7

8

Build/ Map
verify figures

Edit/save
hotspots

Restore
hotspots

Link routes

No

No

No

Yes.
Reposition
hotspots if
necessary.

No

No

No

No

No

No

Yes. Save
hotspots.

No

No

No

No

No

No

No

Yes. Link
index to
route. Save
hotspots.

No

Yes

Add rack
definitions to a
master
configuration

No

No

Yes. Add
changes to
Figure file
and change.

Yes

No

No

Yes. Restore
hotspots,
image paths,
and routers.

No

Remove rack
definition

No

No

Yes. Edit
Figure file to
account for
changes.

Yes

No

No

Yes. Restore
hotspots,
image paths,
and routers.

No

Change rack
contents*

No

No

Yes. Add
changes to
Figure file.

Yes

No

No

Yes. Restore
hotspots,
image paths,
and routers.

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

No

Yes. Add
changes to
new Figure
file and
change
version in
IPC settings.

Yes

No.
Restore
figure
mapping
from
previous
hotspot
file.

Yes

No

No

*New file has
same name. No
other changes.
Modify hotspot
information*
*Change INN
number or
assembly type.

*Change which
figure indexes
are linked to
which racks.
Change part
data*
*Change part
number,
nomenclature,
notes, UPA,
UOC, not figure
data.
Add new part to
existing
hotspot
Create a master
configuration
version with
different rack
definitions
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No

No
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Procedure References
Detailed procedures for the steps indicated in the table can be found at the
following locations in this user guide:
"Creating the IPC ASCII File" on page 3-3
"Parsing" on page 4-6
"Adding Rack Definitions to the Figure File" on page 4-9
"Building the Engine and Figure Database" on page 4-14
"Mapping Figures" on page 4-21
"Creating and Editing Hotspots" on page 4-23
"Saving Hotspot Information" on page 4-33
"Verifying the Master Configuration Database" on page 5-2
"Linking Index Numbers with Routes" on page 6-3
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Glossary
8130
International serviceability tag.
Access Control System (ACS)
The system that controls access of Oracle MRO users to workbenches.
accumulation
The process of collecting the parts of a product that has been disassembled for
service at a staging area for reassembly. Also called marshalling.
agreement
The understanding between a customer and an organization that defines the terms
and conditions of services or repairs.
alternate item
A part of equal fit, form, and function used in place of the original part. Valid
alternates are specified in the Illustrated Parts Catalog.
ATA
Aviation Transportation Association.
auxiliary rack
Rack to which unused figures and uninspected parts are assigned.
blanket agreement
See blanket order.

Glossary-1

blanket order
Typical agreement between an organization and vendor or supplier for products or
services to be provided by the vendor or supplier based on a continuum and
restricted by quantity, price or date.
build goal
The end result in terms of serviceability desired for a particular item, assembly, or
product undergoing service. For example, the build goal might be a minimum time
before the next overhaul of 6000 hours. All parts used in the current service must
meet that requirement.
capability
Part of the Access Control System. Capabilities control user access to workbenches
and functions within workbenches. Capabilities are assigned to roles, and roles are
assigned to workgroups.
See also role, user, workgroup.
contract
In Oracle MRO, contract refers to the common data that is found on all customer
contracts/agreements that drives a service provider’s business.
cost source ID
A unique system-generated identifier for a quantity of one or more of an item that
has an individual unit cost.
CSN
Cycles since new.
CSO
Cycles since overhaul.
CSR
Cycles since repair.
department
An area of particular knowledge or responsibility.

Glossary-2

dump file
A text format file produced to record complex database information in a simplified
format. Dump files can be read with basic text editors.
Engine file (rooteng.iff)
File produced by the Master Configuration WorkBench parser. Defines part and
figure information. Used during database generation. The root prefix is defined in
the IPC Format file.
figure
In the workbench user guides, the term figure generally refers to the IPC references
to a figure in the master configuration database. The term image refers to the actual
graphical representation of the figure, stored as an bitmap image file and displayed
by the workbench applications.
Figure file (rootfigs.iff)
File produced by the Master Configuration WorkBench parser. Defines figure
information. Edited to define racks. Used during database generation. The root
prefix is defined in the IPC Format file.
flat file
ASCII file with data arranged in the form of one record per line. A flat file contains
no embedded structure information.
hotspot
Index number on an electronic image that is linked to displayable database
information about the part. If the index number has a box around it, the link goes to
another figure that illustrates the indicated part or assembly in detail.
Hotspot file
Text file that records the location on an image of the hotspot for each index number
and which information in the master configuration database is associated with each
index number. Also records the routes linked to the hotspot. The Hotspot file can be
used to restore a master configuration that has had its database rebuilt.
Industry Index number (IIN)
Standard industry number assigned to life-limited and time-tracked parts that the
FAA dictates must be tracked.
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Illustrated Parts Catalog (IPC)
Assembly breakdown of a product that lists all parts and alternates indexed to
illustrations.
image
In the workbench user guides, the term image generally refers to the graphical
representation of the figure, stored as an bitmap image file and displayed by the
workbench applications. The term figure refers to the IPC references to the figure in
the master configuration database
internal outside processing
A service supplied by a sister organization as part of a job.
IPC ASCII file (root.asc)
The electronic version of the text of the Illustrated Parts Catalog in ASCII format.
The root prefix is defined in the IPC Format file.
IPC Format file (root.ipc)
Text file that defines the format and keywords used in the IPC ASCII file. Used by
the Master Configuration WorkBench when generating the engine part and figure
database. The root prefix is defined in the IPC Format file.
item master file
A text format dump file of all items recorded in the Oracle materials management
system.
Kits ASCII file (rootkits.asc)
ASCII text file of IPC kit information. Used during parsing. The root prefix is
defined in the IPC Format file.
Kits file (rootkits.iff)
File produced by the Master Configuration WorkBench parser. Defines kit
information. Used during database generation. The root prefix is defined in the IPC
Format file.
mapping
Associating one item with another. In figure mapping, an IPC reference to a figure is
associated with the image file of the scanned figure. Index numbers on figures are
associated with routes that define the tasks appropriate for that part or assembly.
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master configuration
Oracle MRO representation of a product assembly model, including all part,
alternate part, reference information, and figures for all models and versions as
defined in the Illustrated Parts Catalog.
Manufacturing Review Board (MRB)
Group responsible dispositioning parts could not be dispositioned within the
normal processes. Items for disposition are often held in an area specified for MRB
parts.
nomenclature
Official part name as recorded in the Illustrated Parts Catalog for a product.
nonconformance record (NCR)
A record created and tracked for a part or a component when additional
information is required to resolve a situation concerning the status or condition of
the part.
operation
A process or series of actions involved in completing a particular piece of work.
outside processing
A service supplied by a vendor as part of a job.
Picture Book
In Oracle MRO, Picture Book refers to the online IPC representation of a master or
unit configuration. In the Master Configuration Workbench, the Picture Book is
used to create hotspots and associate routes with index numbers on electronic
images. The Inspection and Assembly WorkBenches use the online Picture Book to
guide the disassembly, repair, assembly, and test processes.
purchase order
Typical agreement between an organization and vendor or supplier for product or
services to be provided by the vendor or supplier.
purchase release
A releases of an actual order of goods and services issued against a blanket
purchase agreement. The purchase release specifies the actual quantities and dates
ordered for the items.
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rack
Grouping of components for efficient service. Racks are created in the master
configuration and used to define unit configurations.
repair blanket
Blanket order specifically for services.
role
Part of the Access Control System. Each user is assigned a role. A role consists of a
set of capabilities. Roles are defined with the Access Control WorkBench. Roles are
created in the Access Control WorkBench.
See also capability, user, workgroup.
rollout
The process of moving the material being accumulated to the shop floor for use
during the assembly process. The material requirements for the accumulation job
are moved to the assembly job.
rotable
A repaired part or assembly that is stocked and available use. An assembly that
requires more time for repair than the delivery date allows may be replaced with a
rotable from inventory. When the assembly is repaired, it is placed in inventory and
becomes a rotable.
route
A procedure or instruction used in the disassembly, cleaning, inspection, repair,
parts conversion, assembly, and testing of parts linked to master configurations.
Routes are created and maintained in the Route Management WorkBench. May also
be referred to as router or routing.
route group
A collection of routes assigned to a specific engine type, engine model, and item.
May also be referred to as router group.
sales order
A typical agreement between customer and organization of product or services to
be provided by the organization.
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service type
The type of service to be performed on a unit, such as major overhaul, minor
overhaul, or repair. Routes may be classified with the service type to which they
apply, which provides the ability to filter the number of routes shown.
Sets file (rootsets.iff)
Text file that defines how models and versions are indicated in the Engine and
Figure files after parsing. Used by the Master Configuration WorkBench when
generating the IPC database. The root prefix is defined in the IPC Format file.
supplier
Outside company supplying a product.
top job
Defines the job under which all work to be performed falls. Used for scheduling
purposes. Created in the Unit Configuration WorkBench.
topic
Part of the Access Control System. Topics define information that applies within a
workgroup to all applications. Topics are created and edited with the Access
Control Workbench.
See also topic entry.
topic entry
Part of the Access Control System. Topic entries define information that applies to
specific users or specific client workstations. Topic entries are created and edited
with the Access Control Workbench.
See also topic and topic group.
topic group
Part of the Access Control System. The topic group controls the distribution and
setting of default values in the Oracle MRO system. The topic group is defined in a
Windows ini file containing information relating to applications, workgroups, and
users. Topic groups are edited with the Access Control Workbench.
See also topic and topic entry.
TSN
Time since new.
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TSO
Time since overhaul.
TSR
Time since repair.
unit configuration
Oracle MRO representation of a specific unit received for service, derived from the
master configuration for that product. Also referred to as the as maintained bill of
material.
UOC
Use-on code. In Illustrated Parts catalog, indicates models for which part is valid.
UPA
Units per assembly.
user
Part of the Access Control System. A user definition consists of a name, logon name,
password and assigned specific predefined Access Control System roles. Users are
created in the Access Control WorkBench.
See also capability, role, workgroup.
vendor
Outside company supplying a service to a customer or organization’s product.
workbook
A manual created from an IPC, using only the portions necessary to define a
specific engine configuration.
workgroup
Part of the Access Control System. Workgroups are created in the Access Control
WorkBench.
A workgroup is a grouping with assigned roles to which users are assigned.
Workgroups control access to workbenches and functions within workbenches.
Workgroups are also used to control database paths and configuration parameters
for sets of users.
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Workgroups can contain sets of users that perform similar functions or are
associated according to the resources they use, such as databases and printers.
Workgroups can be mapped closely to the structure of the organization. For
example, each inspection cell may be defined as a workgroup. Branch offices or
departments can also be workgroups.
See also capability, role, user.
workscope
The scope or understanding of all the details and tasks that must be performed for a
particular service. Includes information such as picking rules for replacement parts,
repair value limits, build goal, procedural preferences, and scrap management
parameters.
See also build goal.

Glossary-9

Glossary-10

Index
files required for master configuration,
IPC ASCII file, 3-3
IPC Format file, 3-8
Kits file, 4-8
Sets file, 3-11

Symbols
<root>garb.txt file, 4-7
<root>misc.txt file, 4-7
<root>parse.txt file, 4-7

A

G

attaching parts, 4-6
auxiliary racks, 4-10, 4-14

garbage keys, 3-9

H

D
database, building,

4-14

E
Engine file,

3-3

4-8

F
Figure file
adding rack definitions, 4-9
editing, 4-10
example, 4-12, 4-13
figure mapping, 4-21
figure mapping, restoring, 4-34
figures
adding to IPC, 8-2
adding/removing IPC index, 8-2
removing from IPC, 8-2
files
Engine file, 4-8
Figure file, 4-9

hotspots
creating, 4-23
deleting, 4-28
editing specifications,
moving, 4-28
restoring, 4-34
saving, 4-33

4-28

I
images files, 3-14
index numbers, linking to routes, 6-2
IPC Format file, 3-8
IPC, reviewing, 3-5

K
keywords
Figure file, 4-9
IPC Format file, 3-8
Sets file, 3-11
Kits file, 4-8

Index-1

linking index numbers with,

L
logging in,

2-2
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S
scanning text, 3-3
searching a master configuration,
Sets file, 3-11
status files, parsing, 4-7

M
mapping figures, 4-21
master configuration
building database, 4-14
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